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RESUMEN 

El presente trabajo de investigación tiene como finalidad el estudio del comportamiento 

de fisuras en uniones soldadas,  para lo cual se consideró conveniente seleccionar a la 

mecánica de fractura clásica y al método de los elementos finitos como los medios 

más adecuados para abordar este fenómeno. Durante el estudio se determinó el factor 

de intensidad de tensiones, que es un parámetro que caracteriza la tenacidad de la 

fractura en materiales de comportamiento lineal. 

Es posible distinguir que el trabajo contiene dos partes muy bien definidas. La primera 

parte consiste en la modelación bidimensional de especimenes fisurados, cuyas 

configuraciones son muy conocidas en el ámbito de la mecánica de fractura. La 

segunda parte consiste en volcar la experiencia adquirida y realizar la modelación 

tridimensional de una unión soldada de filete que contiene una fisura superficial en las 

aproximaciones del cordón de soldadura. Los resultados obtenidos de la modelación 

de ambas partes fueron comparados con valores analíticos de diferentes autores 

permitiendo determinar la factibilidad del análisis de la fractura elasto-lineal mediante 

un software de elementos finitos. 
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INTRODUCCIÓN 

En muchos casos la falla de un componente causada por la propagación de una fisura 

puede tener resultados fatales. Problemas de este tipo tienen altos costos 

económicos, ecológicos y humanos. Acontecimientos como los ocurridos en las 

tuberías de transporte del gas de Camisea advierten la necesidad de investigar el 

fenómeno físico de la fractura. 

El análisis por elementos finitos es una poderosa herramienta que da soluciones 

numéricas a una gran gama de problemas ingenieriles y es aceptado como un versátil 

método de análisis para la implementación computacional que unido a los avances 

tecnológicos posibilita modelar una diversidad de problemas complejos con relativa 

facilidad. Es así que con la ayuda de un programa de computadora se pueden probar 

varios parámetros y diferentes configuraciones antes de llegar a la etapa de 

fabricación o se puede conocer el estado en servicio de un componente bajo ciertas 

exigencias. 

Este trabajo desea ser uno de muchos otros que formará parte del conocimiento de 

una escuela sobre la mecánica de fractura y la modelación por elementos finitos en el 

país. Brindará una primera aproximación, en el medio peruano, a la modelación por 

elementos finitos de fisuras en uniones soldadas, para poder estudiar problemas de 

este tipo en el futuro. 

A pesar que no existe una fecha que marque el inicio de la mecánica de fractura se 

puede decir que todo empieza con el trabajo de C.E. Inglis. Él trató de explicar el 

surgimiento de la fractura en discontinuidades geométricas. Siete años después A.A. 

Griffith propuso un enfoque energético para abordar el fenómeno de la fractura para 

materiales frágiles. 

En 1948 G.R. Irwin toma en cuenta la existencia de una pequeña deformación plástica 

en la cabeza de la fisura. Irwin en 1956 dio un gran impulso a la mecánica de la 

fractura cuando propuso el parámetro para caracterizar la fractura para materiales 

elásticos, hoy en día muy conocido como factor de intensidad de tensión (K). 

Ante la situación que un componente falle con una significativa zona de plasticidad en 

la cabeza de la fisura, los científicos tuvieron que generar nuevas teorías. Es así que 

A.A. Wells (1961) y J.R. Rice (1968), independientemente propusieron un nuevo 
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parámetro de fractura. El primero desarrolló el desplazamiento de apertura de la 

cabeza de fisura CTOD (“Crack Tip Opening Displacement”) y el segundo, una integral 

de contorno denominada J Integral. 

Actualmente ASTM cuenta entre sus estándares con el E399-05 y el E1820-06, ambos 

proponen procedimientos para determinar la tenacidad de la fractura y gozan de una 

aceptación general. El primero busca determinar el factor de intensidad crítico KIC y el 

segundo, determinar los parámetros K, J y CTOD. 

Los fundamentos y parámetros de tenacidad de la fractura anteriormente mencionados 

forman parte de la mecánica de fractura clásica. Existe otro enfoque para darle 

tratamiento al fenómeno de la fractura: la mecánica de medios continuos. En un inicio 

fue polémico abordar con medios continuos un fenómeno discontinuo, sin embargo la 

mecánica de medios continuos con el apoyo de los métodos numéricos han generado 

modelos que responden de manera muy real el fenómeno de la fractura.  

Existe una variedad de métodos numéricos que han sido aplicados para evaluar 

problemas de fractura. El método de los elementos finitos ha sido y es un método 

numérico bastante utilizado para el análisis de fisuras en un material elástico y elasto-

plástico. El método cuenta con elementos estándar para tratar la discontinuidad en el 

campo de desplazamientos y tensiones. Estos elementos son capaces de representar 

la singularidad de la cabeza de la fisura, igual a la singularidad teórica. 

Actualmente se cuenta con una variedad de software de modelación numérica, 

muchos de los cuales poseen una gran gama de aplicaciones para la resolución de 

problemas de ingeniería. Se tiene conocimiento que COSMOS/M y ABAQUS tienen la 

capacidad de realizar estudios de fractura. 

El presente trabajo va a evaluar la posibilidad de caracterizar la tenacidad de la 

fractura mediante la modelación numérica en una unión soldada. Los parámetros 

seleccionados para dicha caracterización son el factor de intensidad de tensión (K) y la 

J Integral, ambos bajo condición elástico-lineal y modo de fractura de apertura (Modo 

I). La modelación numérica se llevará acabo con el programa COSMOS/M que cuenta 

con rutinas para la aplicación de problemas de fractura mediante el método de los 

elementos finitos. 
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Todo lo explicado anteriormente da lugar a la siguiente hipótesis. 

Hipótesis 

Mediante la modelación por elementos finitos, a partir del dominio de una herramienta 

de software apropiada, es posible resolver una variedad de problemas reales en el 

campo de la mecánica de la fractura de especimenes fisurados con uniones soldadas. 

Para dar cumplimiento a la hipótesis planteada se proponen los siguientes objetivos. 

Objetivos generales: 

 Validar la factibilidad de modelar una fisura o grieta en material homogéneo

mediante un software de análisis por elementos finitos.

 Realizar la modelación por elementos finitos de una fisura o grieta, teniendo en

cuenta las particularidades de una unión soldada.

 Proponer una metodología para estudiar y predecir el comportamiento de una

fisura en uniones soldadas.

Objetivos específicos: 

 Estudiar los métodos de la mecánica de la fractura que permiten describir el

comportamiento de fisuras bajo diferentes consideraciones.

 Seleccionar un método apropiado para el estudio del comportamiento de fisuras en

uniones soldadas teniendo en cuenta la posibilidad de su modelación con

elementos finitos.

 Comparar y validar los resultados obtenidos mediante la modelación de fisuras en

material homogéneo con los resultados obtenidos por métodos analíticos.

 Realizar la modelación de la fisura teniendo en cuenta las particularidades de las

uniones soldadas, sobre la base de los resultados obtenidos en material

homogéneo.
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 Obtener una metodología, ordenada y coherente, para estudiar el comportamiento

de la fisura en uniones soldadas mediante la modelación por elementos finitos.



CAPITULO I 

ESTADO DEL ARTE DE LA MECÁNICA DE LA FRACTURA PARA EL ESTUDIO DEL 
COMPORTAMIENTO DE FISURAS 

1.1. Introducción. 

El presente capítulo describe de forma muy sintética los conceptos más importantes de la 

mecánica de fractura, los cuales son generados de los consecutivos aportes científicos 

realizados a lo largo de su historia. La mecánica de fractura clásica es aquella que 

contiene los cimientos de esta disciplina y puede ser descrita desde dos puntos de vista, 

la elasto-lineal y la elasto-plástica. Así también se mencionan los mecanismos de 

propagación de fisuras y los fundamentos con base en la mecánica de fractura clásica 

elasto-lineal para su estudio.  

Se describe el constante desarrollo de la mecánica de fractura, que cuenta en la 

actualidad con la mecánica de medios continuos. Bajo el ámbito de esta teoría se han 

generado modelos constitutivos que representan a la fractura de una manera coherente 

con la realidad del fenómeno. 

Por último, se mencionan algunos de los métodos numéricos que han ayudado en la 

investigación de la fractura, haciendo una breve pausa en el método de los elementos 

finitos y en el método de las discontinuidades fuertes, ya que el primero es el método más 

utilizado y el segundo es un método novedoso aunque existe muy poca información sobre 

el mismo. 

1.2. Mecánica de la fractura clásica. 

Los primeros intentos por entender el fenómeno de la fractura se remontan a los trabajos 

realizados por C.E. Inglis. En 1913 propuso el concepto de “concentración de tensiones” 

que es el incremento de esfuerzos en los bordes de una discontinuidad geométrica. Este 

concepto ha proporcionado una explicación al surgimiento de la fractura en fisuras, 

agujeros y otros defectos [20]. El estudio de Inglis consistió en el análisis de la alteración 

que sufre el estado tensional de un punto cualquiera alrededor de un orificio circular en 

una placa plana. Inglis continuó sus estudios llegando a aproximar el orificio circular a 

uno elíptico, consiguiendo que un simple orificio tenga un aspecto similar a una fisura 

[17]. 
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Un vínculo cuantitativo entre el esfuerzo de fractura y el tamaño de la fisura fue el 

resultado del trabajo de A.A. Griffith, cuya publicación sorprendió a la comunidad 

científica en 1920. Griffith utilizó el análisis del estado tensional de un agujero elíptico de 

Inglis para el estudio de la propagación inestable de una fisura. Él aplicó la primera ley de 

la termodinámica al fenómeno de la fractura basándose en un simple equilibrio de 

energía [2]. El modelo de Griffith relacionó correctamente el esfuerzo y el tamaño de 

fisura para materiales frágiles. Los esfuerzos subsecuentes para aplicar este modelo a 

metales resultan en un fracaso [2]. 

En 1939, H.M. Westergaard publicó los resultados de su trabajo, los cuales cobrarían 

importancia con el pasar de los años. Westergaard demostró que las tensiones en la 

cabeza de una fisura en un cuerpo elástico están en función de r/1 , donde r  es la 

distancia entre la cabeza de la fisura y un punto cualquiera alrededor de ella [20]. 

G.R. Irwin (1948) introdujo un avance importante en la mecánica de fractura presentando 

una formulación tensional que evalúa el estado de la cabeza de la fisura, lo cual no se 

había podido hacer anteriormente debido a que los conceptos teóricos hasta esa fecha, 

señalaban que las tensiones en la cabeza de la fisura tendían al infinito, independiente de 

la carga aplicada. Para su formulación, Irwin plantea que el proceso de fractura no puede 

concentrarse en un solo punto, como se deducía de un análisis netamente elástico, sino 

que se presenta en una zona pequeña pero finita, que se denomina zona plástica en la 

cual las tensiones ya dejan de ser infinitas por que parte de la energía elástica se 

consume en la deformación plástica del material próximo a la cabeza de la fisura [5]. 

Entonces, la primera contribución de Irwin es ampliar el acercamiento de Griffith a 

metales gracias a la consideración de una zona plástica pequeña en la cabeza de la 

fisura. En la misma época, E. Orowan independientemente propuso una modificación 

similar a la teoría de Griffith [2]. 

La segunda contribución de Irwin ocurrió en 1956, propuso el concepto de tasa de 

liberación energética y poco después, teniendo como aporte significativo el estudio de 

Westergaard, publicó su investigación donde proporcionó un parámetro de fractura para 

materiales elásticos, hoy en día extensamente conocido como factor de intensidad de 

tensiones ( K ) [20].  

Hasta entonces los conceptos teóricos de la mecánica de la fractura habían alcanzado 

evaluar la existencia de una pequeña cantidad de plasticidad, es en 1961 que A.A. Wells 
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propuso el desplazamiento de las caras de la fisura como un criterio alternativo de 

fractura cuando la falla se ve precedida por una significativa plasticidad. Wells intentó 

aplicar la mecánica de fractura elástico lineal a aceros estructurales de media y baja 

resistencia, resultando materiales demasiado dúctiles para tal aplicación, pero pudo 

apreciar un especial movimiento de separación de las caras de la fisura producto de la 

deformación plástica. Esta observación condujo al desarrollo del parámetro denominado 

como CTOD (“Crack Tip Opening Displacement”) [2]. 

En 1968, J.R. Rice desarrolló otro parámetro para caracterizar el comportamiento no 

lineal del material delante de la cabeza de la fisura. Rice idealizó la deformación plástica 

como un fenómeno elástico no lineal para fines matemáticos y fue capaz de generalizar la 

tasa de liberación de energía para materiales elásticos no lineales. Rice expresó esto en 

términos de una integral de contorno de trayectoria independiente alrededor de la fisura 

que llamó J  [20]. La J -Integral es una forma particular de una invariante integral más 

general propuesta anteriormente por J.D. Eshelby en 1951, quien no llegó a ninguna 

aplicación al fenómeno de la fractura [11]. 

E.T. Wessel, quien era uno de los pioneros en el desarrollo del estándar ASTM E-399 

para la determinación del factor de intensidad crítico, convocó un grupo de investigación 

en "Westinghouse Electric Corporation´s Research and Development Center” para 

abordar la dificultad del problema de la fractura en condiciones elasto-plásticas. Wessel 

dio la responsabilidad de esta difícil tarea a dos de sus más jóvenes ingenieros J.A. 

Begley y J.D. Landes [20]. En 1971, Begley y Landes, encontraron el artículo de Rice y 

decidieron, a pesar del escepticismo de sus compañeros de trabajo, caracterizar la 

tenacidad de fractura con la J -Integral [2]. En 1972, publicaron los resultados de su 

primer estudio en el uso de la J Integral para predecir la iniciación de la fractura en 

condiciones elástico plásticas [20]. Diez años más tarde, su trabajo los condujo a la 

publicación del estándar ASTM E813, el cual con el paso de los años fue reemplazado 

por el E1737, y éste luego por el vigente el E1820-06. 

Para empezar cualquier estudio relacionado a la mecánica de la fractura, es necesario 

identificar los posibles modos de fractura. Irwin en 1956 publicó “Analysis of stress and 

strain near the end of the crack traversing a plate”, donde introdujo los tres modos 

básicos de fractura que pueden ser apreciados en la Figura 1.1 y son descritos a 

continuación [17]. 
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Modo I: Modo de apertura, en el cual las caras de la fisura se separan debido a la 

aplicación de cargas tensiónales normales al plano de fractura. 

Modo II: Modo de deslizamiento, en el cual las caras de la fisura se deslizan una sobre la 

otra y las cargas tensiónales son paralelas al plano de la fisura. 

Modo III: Modo de deslizamiento lateral, donde las caras de la fisura se deslizan 

lateralmente una respecto de la otra. 

Fig. 1.1. Los tres modos básicos de fractura. 

La situación más compleja corresponde a una combinación de los tres modos, sin 

embargo el modo de apertura es el modo de fractura más común en componentes 

metálicos [20]. Los sub-índices I, II y III harán referencia al tipo de modo de fractura 

analizado. 

La mecánica de fractura clásica puede ser clasificada en mecánica de fractura elasto-

lineal (MFEL) y en mecánica de fractura elasto-plástica (MFEP). Si la curva esfuerzo-

deformación de un material tiene un comportamiento lineal, se debe aplicar la MFEL y los 

parámetros que puede caracterizar la tenacidad a la fractura son la tasa de liberación 

energética (G ) y el factor de intensidad de tensiones ( K ). En este régimen la zona 

plástica que se origina en la cabeza de la fisura es pequeña si se compara con el tamaño 

de la fisura. Ahora, si la curva tiene un comportamiento elasto-plástico y la zona plástica 

en la cabeza de la fisura es significativa, se debe aplicar la MFEP y los parámetros 

responsables de la caracterización para este régimen serán el CTOD y la J -Integral [20]. 

A continuación, la Figura 1.2 presenta un esquema que relaciona los parámetros que 

caracterizan la tenacidad a la fractura con el comportamiento del material y el nivel de 

plasticidad en la cabeza de la fisura. 
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Fig. 1.2. Relación entre la respuesta esfuerzo-deformación, nivel de plasticidad en la 

cabeza de la fisura, el tipo de mecánica de fractura y parámetros de fractura. 

1.2.1. Mecánica de fractura elástica lineal MFEL. 

La teoría de la mecánica de fractura elástico lineal ha sido desarrollada para materiales 

con un comportamiento elástico, es decir para materiales que obedecen a la ley de 

Hooke. La concentración de tensión en los alrededores de la cabeza de la fisura provoca 

que en estas zonas el valor de la tensión llegue a ser mayor que la tensión de fluencia del 

material, por lo que se generen deformaciones plásticas. Si la zona de la deformación 

plástica es lo suficientemente pequeña para que el comportamiento global del material 

siga siendo elástico lineal, es factible aplicar la mecánica de fractura elástica lineal [15]. 

El aspecto importante de la mecánica de fractura es poder definir si una fisura bajo 

ciertas condiciones de tensión permanecerá estable o si por el contrario se prolongará. 

Para poder predecir este comportamiento, la mecánica de fractura elástica lineal cuenta 

con dos criterios, ambos diferentes en su concepción aunque se encuentran 

relacionados. El primer criterio en términos de un balance energético y el segundo 
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basado en un campo de tensiones existente en la cabeza de la fisura denominado como 

factor de intensidad de tensiones ( K ) [5]. 

1.2.1.1. Balance energético. 

La presencia de discontinuidades en un material provoca el incremento de las tensiones 

en los bordes de éstas, conocido como concentración de tensiones. Los primeros 

estudios de este fenómeno fueron desarrollados por C. E. Inglis en 1913. Inglis realizó un 

estudio elástico sobre la alteración que sufre el estado tensional en un punto cualquiera 

de una placa plana con orificio circular y sometido a un estado de tensión homogéneo. Al 

dar continuidad a su trabajo, Inglis pudo estudiar una placa plana con un orificio elíptico 

como la aproximación de un material fisurado, con lo cual consiguió que un simple 

agujero elíptico represente a una fisura y que las formulaciones analíticas producto del 

estudio puedan evaluar el estado tensional de la cabeza de la fisura. Se cuenta con la 

siguiente expresión para agujeros elípticos muy delgados [17]: 

)/(2 baMAX σσ ≡  para ba /  >> 2/1 (1.1) 

Donde MAXσ  es la tensión máxima en la cabeza de la fisura, σ  es el campo de tensión 

remota uniforme, a2  y b2  son las longitudes de los ejes de la elipse (ver Figura 1.3). 

Fig. 1.3. Placa finita con un orificio elíptico sometido a un estado plano de tensiones. 

El criterio de concentración de tensiones para un orificio elíptico tiene limitaciones, ya que 

si se pretende que el orificio elíptico se aproxime cada vez más a una fisura, b  tendría 
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que tener una tendencia a cero, provocando que la tensión en la cabeza de la fisura 

tienda al infinito independientemente de la carga aplicada. 

El criterio energético de propagación de fisuras fue planteado por A.A. Griffith en 1920. 

Griffith tomó la solución elástica del orificio elíptico en una plancha plana finita y concluyó 

que debido a la singularidad de tensiones con valores infinitos en la cabeza de la fisura, 

no podría utilizarse la tensión como criterio de fractura sino que el problema debía 

plantearse en términos de un balance energético con base en la primera ley de la 

Termodinámica [2, 5]. 

La formulación de Griffith considera una placa finita homogénea e isótropa, de módulo de 

elasticidad E , con una fisura central de forma elíptica de longitud a2 , que es deformada 

elásticamente por un campo de tensiones σ  como lo ilustra la Figura 1.3. Griffith 

encontró que la energía elástica (U ) almacenada en la placa por unidad de espesor es 

[5]: 

E
aU

22πσ
= (1.2) 

Y definió la energía de superficie (W ) como [5]: 

SaW γ4= (1.3) 

Siendo Sγ  la energía específica de superficie y a4  el área de la superficie de 

agrietamiento. En este caso, la fisura es de espesor unitario, de longitud a2  y formada 

por dos caras. 

Cuando la fisura comienza a incrementar su longitud, entra en un estado de equilibrio 

inestable bajo las tensiones aplicadas y se transfiere energía de la zona no fracturada a 

la fractura, a través de un proceso de conversión de energía elástica en energía de 

superficie. Este equilibrio de energías puede expresarse matemáticamente como [5]: 

da
dW

da
dU

= (1.4) 

Derivando las ecuaciones (1.2) y (1.3) con respecto al incremento de la longitud de la 

fisura  da , se obtiene: 
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E
a

da
dU 22πσ

= (1.5) 

Sda
dW γ4= (1.6) 

Reemplazando  (1.5) y (1.6) en (1.4) se despeja la tensión, que corresponde a la tensión 

para la cual se inicia la propagación de la fisura, conocida como tensión de fractura de 

Griffith Cσ  [2, 5]: 

a
E S

C π
γσ 2

= (1.7) 

El trabajo de Griffith tiene dos aportes fundamentales para la mecánica de la  fractura. En 

primer lugar demuestra que la fractura resulta de un proceso de conversión de energía 

que no depende solamente de la tensión aplicada sino también del tamaño de la fisura y 

en segundo lugar se cuenta con una expresión que relaciona la tensión de fractura y el 

tamaño de la fisura comprobada repetidamente en sólidos frágiles ideales [2, 5, 19]. 

La mayoría de los metales experimentan en alguna medida una deformación plástica 

antes de la fractura, produciendo un enrollamiento del extremo de la fisura que aumenta 

el valor de la tenacidad a la fractura. G.R. Irwin y E. Orowan trabajaron cada uno 

independientemente en 1948 para modificar la ecuación (1.7), con el objetivo de incluir un 

término que representara la energía de deformación plástica asociada a la propagación 

de la fisura, logrando la siguiente expresión [2, 19]: 

( )
a

E PS
C π

γγ
σ

+
=

2
(1.8) 

Donde Pγ  es el trabajo plástico por unidad de superficie creada y es normalmente mucho 

más grande que Sγ . La expresión (1.8) puede generalizarse para tener en cuenta 

cualquier tipo de disipación energética: 

a
EU r

C π
σ

2
= (1.9) 
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Donde rU  es la energía de fractura del material. La ecuación (1.9) puede ser aplicada a 

materiales con un comportamiento elasto-lineal y algún efecto plástico es confinado a una 

pequeña zona plástica en la cabeza de la fisura [2, 19]. 

Si se analiza una sola cabeza de fisura, entonces sólo se tendría la mitad de la placa y 

por lo tanto las ecuaciones (1.5) y (1.6) quedan expresadas de la siguiente manera [2]: 

E
a

da
dU 2πσ

= (1.10) 

Sda
dW γ2= (1.11) 

En 1956 Irwin propuso un enfoque energético de la fractura, que en esencia es 

equivalente al modelo de Griffith, excepto, que dicho enfoque es más conveniente para 

resolver problemas de ingeniería. El criterio que presentó está expresado en términos de 

un balance entre la energía disponible (suministrada fundamentalmente por las fuerzas 

externas) y la energía requerida para que se presente tal extensión de la fisura [2, 5]. 

La energía disponible para la extensión de la fisura usualmente se denomina tasa de 

liberación energética (G ) y es igual a dadU , de tal manera que la ecuación (1.10) se 

puede  expresar como [5]: 

G
E

a
da
dU

==
2πσ

(1.12) 

Por su parte, la energía requerida ( dadW ), también conocida como energía de fractura 

o tasa crítica de liberación energética ( ICG ) es una propiedad del material que se puede 

considerar constante en comportamiento elástico. [5]. 

ICG
da
dW

= (1.13) 

La condición de ICG  se presenta cuando la tensión σ  adquiere un valor crítico Cσ , para 

el cual dadWdadU = y por lo tanto de las ecuaciones (1.12) y (1.13) se obtiene: 
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IC
C G

E
a
=

.. 2σπ
ó 

a
EGIC

C .π
σ = (1.14) 

Esta es una forma más general que la ecuación (1.9) para expresar la tensión de 

agrietamiento de Griffith con la ventaja de que no involucra la energía especifica de 

superficie Sγ [5]. 

En resumen, el criterio energético de la fractura consiste en comparar la energía 

disponible para la propagación de una fisura denominada tasa de liberación energética 

G  con la energía necesaria para producir el agrietamiento denominada tasa crítica de 

liberación de energía ICG  [5]: 

Si G < ICG , entonces da =0, no hay extensión de la fisura (estable). 

Si ICGG = , entonces da ≥0, posible extensión cuasi-estática de fisura. 

Si G > ICG , entonces da >0, crecimiento dinámico de la fisura (inestable). 

1.2.1.2. Factor de Intensidad de Tensiones K

A.A. Griffith planteó el criterio energético para evitar el problema de la singularidad en la 

cabeza de la fisura, donde de acuerdo con la solución elástica, las tensiones tienden al 

infinito al aplicar cualquier carga. G.R. Irwin desarrolló uno de los aportes más 

importantes a la mecánica de fractura al formular el problema de la propagación de la 

fisura en términos del estado tensional de la zona próxima a la cabeza de la fisura 

denominándola como Factor de Intensidad de Tensiones ( K ). Irwin concluyó que el 

fenómeno de la fractura no podría concentrarse en un solo punto como lo hacia la 

solución elástica, sino que existe una pequeña zona plástica en la cabeza de la fisura, la 

cual por el efecto de la deformación absorbe gran cantidad de energía manteniendo las 

tensiones dentro de valores finitos [2, 17].  

El factor de intensidad de tensión K  representa la amplitud de la singularidad tensional 

en la cabeza de fisura y depende de la geometría del cuerpo, del tamaño de la fisura y de 

la carga aplicada [20]. Este factor se define en función del modo de fractura, dando lugar 

a tres tipos básicos: IK , IIK  y IIIK . Cabe resaltar que el modo de fractura que se 

presenta con mayor frecuencia en componentes metálicos es el modo I o modo de 

apertura [17]. 
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El análisis del estado tensional alrededor de la cabeza de la fisura bajo el modo I de 

fractura propone una solución general para una fisura de longitud a2  elíptica, sometida a 

un campo de tensiones uniformes σ  (ver Figura 1.4) [15]: 

( )θ
π

σ ij
I

ij f
r

K
.2

= (1.15) 

aK I .πσ= (1.16) 

Siendo ijσ  los componentes de tensión de un punto cualquiera de la plancha, ( )θijf

funciones trigonométricas conocidas, IK  el factor de intensidad de tensiones bajo el 

modo I de fractura, r  y θ  las coordenadas polares, tomando a la cabeza de la fisura 

como origen. 

Fig. 1.4. Placa sometida a un estado de tensiones en las proximidades de una fisura. 
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Los valores de IK  para una variedad de configuraciones son coleccionados por 

diferentes bibliografías. Para los especimenes más comunes, la expresión para estimar el 

valor de IK  queda reducida a la siguiente forma [20]: 

)(. baFaK I πσ= (1.17) 

Siendo )( baF  un factor geométrico o de forma adimensional definido por la relación 

longitud de fisura y ancho del espécimen. A continuación se presentan tres especimenes 

muy conocidos, el “Center Cracked Tension”, “Double Egde Notch Tension” y “Single 

Edge Notch Tension” [21]: 

 Center Cracked Tension (CCT).

Plancha plana que contiene una fisura en la parte central que atraviesa a la plancha a lo

largo de todo el espesor B . Siendo a  la semi-longitud de la fisura y b  la semi-longitud

del ancho del espécimen.

( )
b
abaF
.2

.
sec

π
= (1.18) 

Fig. 1.5. Especimen “Center Cracked Tension” (CCT). 
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 Double Edge Notch Tension (DENT).

Plancha plana que contiene dos fisuras localizadas en sus bordes laterales que

atraviesan todo el espesor B . Siendo a  la longitud de la fisura y b  la semi-longitud del

ancho del espécimen.

( )
b
a

a
bbaF

.2

.
tan

.

.2 π
π

= (1.19) 

Fig. 1.6. Especimen “Double Edge Notch Tension” (DENT). 

 Single Edge Notch Tension (SENT).

Plancha plana que contiene una fisura localizada en uno de los bordes laterales que

atraviesa todo el espesor B . Siendo a  la longitud de la fisura y b  el ancho del

espécimen.

( )
2/3

4

)/1(

/265.0857.0
)/1(265.0

ba
bababaF

−
+

+−= (1.20) 

Fig. 1.7. Especimen “Single Edge Notch Tension” (SENT). 
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Al igual que en el enfoque energético, el criterio de propagación de una fisura en términos 

del factor de intensidad de tensiones queda definido de la siguiente manera [2]: 

Si K < ICK , entonces no hay extensión de la fisura (estable). 

Si ICKK = , entonces posible extensión cuasi-estática de fisura. 

Si K > ICK , entonces crecimiento dinámico de la fisura (inestable). 

Existe una relación entre la tasa de liberación energética y el factor de intensidad de 

tensiones [2]: 

E
KG

2

= (1.21) 

)1( 2
2

ν−=
E

KG   (1.22) 

Donde ν  es la relación de Poisson. La ecuación (1.21) es para un estado plano de 

tensiones y la ecuación (1.22) para un estado plano de deformaciones. 

1.2.2. Mecánica de la Fractura Elástico Plástica MFEP. 

La Mecánica de Fractura Elástica Lineal (MFEL) se aplica cuando la deformación no 

lineal del material es encajonada en una pequeña región cerca de la cabeza de fisura. 

Las limitaciones de la MFEL se presentan cuando regiones considerables del material se 

deforman plásticamente antes de que una grieta se propague. La Mecánica de Fractura 

Elástico Plástica (MFEP) es propuesta para analizar estas significativas zonas plásticas 

que se presentan en la cabeza de la fisura. 

Este capítulo describe dos de los parámetros que caracterizan la MFEP, el CTOD “crack 

tip opening displacement” y la J -Integral.  El primero fue desarrollado por D. Dugdale y 

G. Barenblatt para que más tarde sea utilizado por A. Wells, muy popular en Europa, el

segundo es propuesto por J.R. Rice, extensamente usado en los Estados Unidos. El

desarrollo de ambos criterios ha generado un mayor conocimiento sobre el

comportamiento de la plasticidad en la cabeza de la fisura para materiales de

comportamiento elasto- plástico [5, 17].
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1.2.2.1. CTOD (Crack Tip Opening Displacement) 

El método propuesto por A. Wells se basa en admitir la existencia de una zona plástica 

en la cabeza de la fisura y que ésta se abre en un plano normal a la dirección de la carga 

aplicada [17].  

Cuando una placa infinita con una fisura pasante de longitud c2  en su centro es 

sometida a una tensión σ , las caras de la grieta se abren, y si la deformación es 

únicamente elástica, la separación de las caras se denomina COD (Crack Opening 

Displacement) (ver Figura 1.8) y puede ser expresada como [15]: 

224 xc
E

COD −=
σ

(1.23) 

Fig. 1.8. COD para una fisura central en una placa elástica infinita. 

En la cabeza de la fisura, es decir para cx = , la abertura de la grieta se denota como 

CTOD (Crack Tip Opening Displacement), siendo su valor nulo si la deformación en este 

punto es exclusivamente elástica. En el supuesto de que se desarrolle plasticidad en la 

cabeza de la fisura, ésta perderá su configuración afilada (ver Figura 1.9). Una estimación 

de COD de la fisura puede ser obtenida mediante la corrección debido a la zona plástica. 

La longitud de la fisura en la expresión (1.23) puede ser expresada como prc + , 

originando entonces [15]: 
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22)(
4 xrc
E

COD p −+=
σ

(1.24) 

pp cr
E

crc
E

CTOD 2
4

)(
4 22 σσ

≈−+= (1.25) 

c

x

rp

Zona plástica

Fig. 1.9. Corrección debido a la presencia de plasticidad en la cabeza de la fisura. 

1.2.2.2 J-Integral 

El concepto de la J -Integral fue definido por J.R. Rice para describir el fenómeno del 

crecimiento de una fisura desde un enfoque energético en materiales de comportamiento 

frágil y dúctil. La integral de Rice es una integral bidimensional de contorno independiente 

del camino, definida en las regiones cercanas a la cabeza de la fisura y expresa la 

energía por unidad de área necesaria para crear nuevas superficies de fractura en un 

cuerpo cargado que contiene una fisura (ver Figura 1.10), cuya expresión es la siguiente 

[15, 19]: 

ds
x
uTdyUJ d ∂
∂

−= ∫ ∫
Γ

(1.26) 

Donde dU  es la densidad de energía de deformación, Γ  es el contorno arbitrario 

alrededor de la cabeza de la fisura, T  es el vector tracción perpendicular a Γ , u  es el 

vector desplazamiento, ds  es una porción de Γ , x  e y  son las direcciones de los ejes 

de coordenadas. 
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Fig.1.10. Contorno arbitrario alrededor de la cabeza de la fisura. 

1.3. Mecanismos de fractura. 

El proyecto de estructuras con las técnicas de la Mecánica de la Fractura se basa en el 

reconocimiento de que un componente estructural puede estar fisurado; ya sea 

inicialmente o porque las fisuras se desarrollen durante el servicio [11]. Bajo las 

condiciones de carga cíclica, carga sostenida en presencia de medios hostiles o una 

combinación de estas dos, los niveles de IK  de las fisuras pueden crecer y alcanzar el 

ICK  del material. Estas fisuras son conocidas como fisuras sub-críticas, cuyo crecimiento 

determina la vida de un componente [20]. Los mecanismos de crecimiento de las fisuras 

sub-críticas son: la fatiga y la corrosión bajo tensión, y raramente se presentan aislados 

simplificando considerablemente su tratamiento cuando uno de estos fenómenos es el 

predominante [11]. 

1.3.1 Fisuración por fatiga. 

P.C. Paris realizó varios estudios experimentales que condujeron a proponer que en un

diagrama entre el logaritmo de la velocidad de propagación de la fisura, dNda /  y el

logaritmo del incremento del factor de intensidad de tensiones, minmax KKK −=∆ , se

obtiene una curva sigmoidal como es representada esquemáticamente en la Figura 1.11.
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Fig. 1.11. Esquema que caracteriza el crecimiento de una fisura por fatiga. 

El comportamiento del crecimiento de la fisura puede ser dividido en tres regiones. La 

región I es aquella donde la pendiente de la curva es alta. Existe un valor de K∆  llamado 

umbral OK∆  por debajo del cual la fisura no se propaga. El comportamiento de la fisura 

en esta región está influenciado por la microestructura del material, por la relación entre 

las tensiones máxima y mínima máxmínR σσ=  y por el medio ambiente que rodea la 

fisura. En la región II, zona intermedia de la curva, la microestructura, la relación entre las 

tensiones, R, y hasta el medio ambiente tienen poca influencia. Esta región, conocida 

como la región de Paris, es representada como una linea recta y puede ser descrita por: 

mKA
dN
da

)(∆=  (1.27) 

Siendo A  y m parámetros que dependen del material. Ver tabla 1.1. 

Tabla.1.1. Valores de A y m para la región de Paris [11]. 

MATERILES A  m

Aluminio 45x10-9 2,9 

Acero ferrítico perlítico 7x10-9 3,0 

Titanio 7x10-9 4,4 
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La tercera región se caracteriza por un nuevo incremento en la pendiente de la curva 

alcanzando un valor crítico CK . La microestructura y la relación tensional R vuelven a 

cobrar importancia, así como el espesor de la probeta. 

Cabe resaltar que el estándar ASTM E647-05 describe la determinación de intervalos de 

crecimiento de la fisura por fatiga, cuyos resultados son expresados en términos del 

factor de intensidad de tensiones de la cabeza de la fisura ( K∆ ), definidos por la teoría 

de la elasticidad lineal. 

1.3.2. Fisuración por corrosión bajo tensión. 

Si un componente se encuentra bajo condiciones de cargas estáticas muy inferiores al 

límite elástico puede fisurarse si además se encuentra en un ambiente corrosivo. Los 

conceptos de la mecánica de fractura pueden ser aplicados para determinar el umbral 

( ISCCK ), por debajo del cual no se produzcan roturas por corrosión bajo tensión. Se 

realizan diferentes ensayos con el objetivo de elaborar un diagrama velocidad de 

propagación de la fisura, dtda / , en función de IK  para un sistema material/medio como 

se puede apreciar en el esquema de la Figura 1.12.  

Fig. 1.12. Esquema que relaciona la velocidad de la fisura dtda  en función de IK  para 

la fisuración por corrosión bajo tensión. 

Estos ensayos proporcionan información que permiten cuantificar las predicciones de 

vida y ayudan a entender los mecanismos de la corrosión bajo tensión [11]. En la etapa I, 
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la velocidad depende mucho de IK , de forma que pequeñas variaciones en IK  pueden 

producir grandes variaciones en la velocidad. En la etapa II la velocidad es prácticamente 

independiente de IK   y representa un intervalo dentro del cual la cinética del crecimiento 

está dominada por el proceso químico de fragilización y no por el estado tensional. En la 

etapa III de nuevo la velocidad  de propagación depende de IK , porque se está cerca del 

valor crítico ICK  [11]. 

El estándar ASTM E1681-03 describe un método de prueba para la determinación de los 

parámetros de factor de intensidad de tensión de umbral en un determinado ambiente 

para materiales metálicos bajo cargas constantes sobre especimenes de prueba. 

1.4. La mecánica de la fractura mediante los medios continuos. 

En 1960 nace un enfoque distinto a la mecánica de fractura clásica para estudiar los 

fenómenos discontinuos: la mecánica de medios continuos. En un inicio fue altamente 

cuestionable la representación de un fenómeno discontinuo utilizando técnicas de estudio 

basadas en la mecánica de medios continuos, provocando una contradicción conceptual, 

pero a pesar de la polémica, este nuevo enfoque se abrió campo con los trabajos de Ngo 

y Scordelis en 1967. La mecánica de medios continuos por métodos numéricos, como los 

elementos finitos, han dado origen a formulaciones coherentes para el tratamiento del 

fenómeno de la fractura. Estas formulaciones han podido incorporar múltiples 

complejidades que son muy difíciles contenerlas en las expresiones de la mecánica de 

fractura clásica [17]. 

La hipótesis básica de aproximación que hace la mecánica de medios continuos del 

problema discontinuo de fractura se basa en no intentar describir exactamente lo que 

ocurre en el propio punto donde se provoca el desmembramiento o discontinuidad, en 

realidad sólo intenta obtener la respuesta global de una estructura afectada por este 

fenómeno de fractura. Dicho de otra manera, importa más las consecuencias que 

introduce la fractura en el comportamiento mecánico del sólido, que el hecho en sí 

mismo. Así pues, la respuesta que se obtendrá con estos modelos continuos será 

suficientemente buena sin que sea necesario exigir al modelo la representación de una 

discontinuidad real. En resumen, sólo se pedirá a este modelo que represente la 

consecuencia tenso-deformacional que provoca esta discontinuidad. Se entenderá así 

que la fractura es el resultado de complejos comportamientos que llevan a la pérdida de 

resistencia, rigidez, etc., del material en ciertos puntos de la estructura [17]. 
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La ventaja de los modelos continuos es que pueden incorporar una gran variedad de 

comportamientos: elasticidad, daño, plasticidad, viscoelaticidad, viscoplasticidad, etc. 

Todos estos comportamientos pueden tratarse conjuntamente como complejos estados 

tensionales, provocados por cargas externas, humedad, temperatura, cambios de fase de 

la materia, etc. Actualmente se puede mencionar una nueva formulación que incorpora 

las cargas cíclicas, incluyendo por lo tanto el fenómeno de la fatiga [17]. 

Bajo el ámbito de la mecánica de medios continuos, el fenómeno de la fractura está 

estrechamente relacionado con la localización de intensos modos de deformación. En los 

últimos años ha tomado fuerza un enfoque fenomenológico del problema de localización 

de deformaciones, cuyo estudio es mediante saltos en el campo de desplazamientos, 

conocidos como discontinuidades fuertes [18]. 

1.5. Mecánica computacional de falla. 

La convergencia entre la mecánica del sólido (mecánica de fractura clásica o mecánica 

de medios continuos), las herramientas computacionales y los métodos numéricos puede 

ser denominada como mecánica computacional de falla, la cual a ganado creciente 

popularidad en los últimos años. La mecánica computacional de falla conjuntamente con 

estudios de los materiales dan origen a un modelo constitutivo que resulta ser una 

formulación matemática capaz de describir o representar el fenómeno físico que ocurre 

en un sólido ideal [17].  

Fig. 1.13. Modelos constitutivos y las disciplinas que lo originan. 
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Las herramientas computacionales han tenido una enorme influencia en todas las ramas 

de la ingeniería, y la mecánica de la fractura no ha sido la excepción. La modelación 

numérica es un medio importante en el análisis de fractura ya que facilita la resolución de 

problemas y economiza el tiempo de ejecución [5]. 

Existen software comerciales de modelación numérica que han logrado incorporar una 

amplia gama de análisis para la resolución de problemas de ingeniería, algunos de éstos 

han incorporado rutinas de mecánica de fractura como es el caso de dos potentes 

programas de análisis por elementos finitos, COSMOS/M y ABAQUS. 

La modelación computacional debe contar con un método numérico para el análisis de 

algún problema. Algunos de los métodos numéricos que han sido aplicados para evaluar 

problemas de fractura son: 

• Método de los Elementos Finitos

• Método de los Elementos Discretos

• Método de Discontinuidad Fuerte

• Método de las Diferencias Finitas

• Método de los Elementos de Contorno

La idea general del método de los elementos finitos es la división de un continuo en un 

conjunto de pequeños elementos interconectados por una serie de puntos llamados 

nodos. Las ecuaciones que rigen el comportamiento del continuo regirán también el 

comportamiento del elemento. De esta forma se consigue pasar de un sistema continuo 

con infinitos grados de libertad, a un sistema discreto con un número finito de grados de 

libertad [12]. 

El método de los elementos finitos en la mecánica de fractura ha sido y es actualmente 

una herramienta bastante utilizada tanto en el rango elástico como en el elasto-plástico. 

Se desarrollaron elementos finitos especiales para tratar la discontinuidad en el campo de 

desplazamientos y tensiones en la cabeza de la fisura que contienen una singularidad del 

campo de desplazamientos igual a la singularidad teórica. Estos elementos presentan 

como desventaja la incapacidad de reproducir la deformación constante debido a los 

movimientos de cuerpo rígido, así como dificultades con el análisis termo-mecánico. 

Actualmente se utilizan elementos planos isoparamétritos estándar para tensión plana, 

deformación plana y axisimetría. La singularidad de estos elementos isoparamétricos se 
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logra desplazando la posición de los nodos intermedios de los lados (elementos de 

segundo orden) hacia el vértice de la cabeza de la fisura, situándose en el cuarto de 

longitud del lado, como se puede apreciar en la Figura 1.14. La diferencia entre los 

elementos singulares y los elementos no-singulares o elementos estándar forzados a la 

singularidad, es que estos últimos no presentan las desventajas de los primeros [17]. 

Fig. 1.14. Distorsión nodal para los elementos cuadráticos de 8 nodos. 
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CAPÍTULO II 

MODELACIÓN DEL COMPORTAMIENTO DE FISURAS EN MATERIAL HOMOGÉNEO 
CON UN SOFTWARE DE ELEMENTOS FINITOS. 

2.1. Introducción 

El primer capítulo introdujo los términos factor de intensidad de tensiones K  y J -Integral, 

ambos se definen como parámetros de la tenacidad a la fractura para un material elasto-

lineal y elasto-plástico respectivamente. Si bien es cierto que la J -Integral es vinculada 

con el comportamiento elástico plástico, existe la posibilidad de caracterizar un material 

elástico lineal en términos de la Integral de Rice, ya que para estos materiales la J  es 

igual a la tasa de liberación energética G , la cual a su vez está relacionada con K  

mediante una expresión matemática descrita en la sección 1.2.1.2. 

El presente capítulo está dirigido a la determinación de K  y a la J -Integral como los 

principales parámetros para la caracterización de la tenacidad de la fractura elasto-lineal 

mediante la modelación por elementos finitos para tres especimenes de configuraciones 

conocidas en el ámbito de la mecánica de la fractura. Los resultados obtenidos serán 

comparados con los valores analíticos propuestos por diferentes autores, consiguiendo de 

esta forma validar la modelación realizada. 

2.2 Selección y justificación del método apropiado para la modelación por 
Elementos Finitos. 

Durante el desarrollo del primer capítulo se describieron dos teorías que hacen frente al 

estudio de la fractura: la mecánica de fractura clásica y la mecánica de medios continuos, 

ambas cuentan con muy interesantes enfoques para abordar el fenómeno de la fisura. Por 

otro lado, en la actualidad también se cuenta con los métodos numéricos que apoyados 

de las herramientas computacionales tienen la capacidad de estudiar casos de relativa 

simplicidad hasta casos muy complejos. Para alcanzar los objetivos de la investigación se 

ha seleccionado la mecánica de fractura clásica y el método de los elementos finitos como 

los medios necesarios para enfrentar el estudio del comportamiento de la fisura por las 

razones que a continuación se exponen. 
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De acuerdo con S. Oller [17], la mecánica de medios continuos ha dado origen a 

formulaciones coherentes para el tratamiento de la fractura, las cuales han logrado 

incorporar múltiples complejidades al fenómeno de la fisura. A pesar de estas ventajas, un 

trabajo de investigación bajo esta teoría se ve limitado debido a que la información 

bibliografía al respecto es escasa, no teniendo suficientes fuentes para contrastar ideas, 

conceptos, resultados, etc.; además no se cuenta con una herramienta computacional 

basada en este enfoque. 

Este trabajo desea ser parte de una escuela en formación de la mecánica de fractura en 

el país, cuyo proceso necesita de los fundamentos de la disciplina, por ello el interés por 

conocer y aplicar el enfoque clásico. La mecánica de la fractura clásica recoge los 

cimientos del conocimiento de los pioneros en el estudio del fenómeno de la fractura 

cuyos modelos tratan de representar el fenómeno lo más fielmente posible, mientras que 

los modelos continuos representan las consecuencias tenso-deformacional que provoca la 

discontinuidad. 

En la actualidad se cuenta con el método numérico de los elementos finitos extensamente 

usado para análisis de problemas de ingeniería, incluyendo el análisis de fractura. El 

software COSMOS/M, es un programa de análisis por éste método y ofrece una amplia 

gama de aplicaciones en diversas áreas, capaz de efectuar el análisis en las 

inmediaciones de la cabeza de la fisura de un modelo bajo diferentes condiciones, 

logrando caracterizar la tenacidad a la fractura elasto-lineal mediante los parámetros K  y 

J . 

2.3 Modelación de la fisura en material homogéneo con el software COSMOS/M. 

La mecánica de fractura ha utilizado una gran variedad de configuraciones, a lo largo de 

su historia, para el estudio del comportamiento de fisuras. Dichas configuraciones no son 

otra cosa que especimenes con particularidades geométricas, las cuales están sometidas 

a determinadas cargas y contienen una o más fisuras en diferentes posiciones. Estos 

especimenes pueden ser encontrados en las bibliografías que hacen referencia al estudio 

del fenómeno de la fractura, por ejemplo especimenes como “Bend Specimen” SE(B) y 

“Compact Specimen” C(T), son mencionados por los estándares para determinar la 
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tenacidad a la fractura crítica de un material mediante ensayos de laboratorio [9,10]. La 

bibliografía de H. Tada, “The stress analysis of cracks handbook” [21], describe un grupo 

de especimenes aceptados como los más conocidos o los más comunes, y precisamente 

son tres de éstos los seleccionados para realizar el estudio de modelación mediante el 

método de los elementos finitos. Los tres especimenes CCT, DENT y SENT (ver Figura 

2.1) descritos en la sección 1.2.1.2, fueron seleccionados debido a que sus 

configuraciones geométricas de relativa simplicidad permiten realizar un trabajo de 

modelación de forma más ágil y generar una metodología contundente, al poder validar 

los resultados. 

Fig. 2.1 Tres de los especimenes de prueba más comunes: a) “Center Crack Tension”, b) 

“Double Edge Notch Tension” y c) “Single Edge Notch Tension”. 

La configuración geométrica de un espécimen involucra información dimensional e 

información concerniente a las fisuras que contiene: número, localización,  tamaño y 

forma. Las condiciones de contorno hacen referencia a las restricciones y las cargas 

(puntuales o distribuidas) que actúan sobre el espécimen. Ésta información 

conjuntamente con algunas consideraciones debe ser sintetizada en un modelo, el cual 

resulta ser una idealización, tal que responda de la forma más fielmente posible a la 

situación bajo la cual se encuentra sometido el espécimen en estudio. Las 

consideraciones tomadas para elaborar el modelo, son hechas con el fin de simplificar el 

estudio y generar menos gasto computacional, por ejemplo la geometría de un modelo 

puede quedar definida a la mitad del tamaño del espécimen original ya que se cuenta con 
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un plano de simetría. Otra consideración consiste en trabajar un modelo en dos 

dimensiones si su configuración y condiciones de contorno lo permiten, por ejemplo una 

plancha plana fisurada a lo largo de todo el espesor puede ser modelada en el plano (2D). 

En la Figura 2.2 se pueden apreciar los tres especimenes seleccionados, cuyos 

parámetros dimensionales y cargas aplicadas tienen valores asignados, los cuales serán 

respetados a lo largo de la elaboración del estudio. En estas figuras se pueden apreciar 

los diferentes tamaños de fisura que servirán para la evaluación de la respuesta del 

espécimen ante el incremento de la longitud de la discontinuidad. La misma figura 

muestra los modelos idealizados, cada uno de los cuales contiene la información 

necesaria para responder de forma coherente al estudio de modelación.  

Fig. 2.2. Especimenes CCT, DENT y SENT con sus respectivos modelos idealizados, 

parámetros asignados y condiciones de contorno requeridos para la modelación. 
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Los especimenes CCT y DENT poseen dos planos de simetría por lo cual el tamaño de 

los modelos queda definido como un cuarto del tamaño original, y el modelo SENT cuenta 

con un plano de simetría, por ende tiene la mitad del tamaño original. Las restricciones 

son desplazamientos perpendiculares al lado correspondiente con valores iguales a cero, 

aplicadas en los planos de simetría. Cabe resaltar la existencia de un segmento de borde 

libre de restricciones, el cual está destinado a representar la fisura del modelo. 

El ambiente de trabajo de COSMOS/M es de un sistema completamente modular, 

permitiendo seleccionar las herramientas en función de la necesidad del análisis. La 

interfaz gráfica entre el usuario y el sistema COSMOS/M recibe el nombre de módulo 

GEOSTAR que además de ser el pre y post-procesador, posee un modelador geométrico 

tridimensional similar a cualquier sistema CAD y un generador de malla para el análisis 

por el método de los elementos finitos. En general el usuario, sin necesidad de salir del 

ambiente de GEOSTAR, puede crear el modelo geométrico, enmallarlo, ingresar cualquier 

tipo de información que considere necesaria, realizar el análisis deseado y visualizar los 

resultados. 

El programa COSMOS/M requiere de modelos geométricos como primer paso para 

efectuar cualquier tipo de análisis. Un modelo geométrico es la representación gráfica del 

modelo idealizado y puede ser generado en el mismo programa o importado desde otro. 

Los modelos geométricos necesarios para este trabajo fueron creados en el mismo 

COSMOS/M para evitar alguna incompatibilidad que pueda presentar la importación y 

comprometer negativamente el posterior análisis, además los modelos de los 

especimenes seleccionados poseen una geometría simple y de fácil representación. 

COSMOS/M proporcionar un conjunto de elementos finitos que permiten analizar toda una 

variedad de problemas ingenieriles. El modelo matemático de un elemento simula el 

comportamiento físico, mientras que la forma del elemento cumple con la función de 

aproximar la geometría del componente que se desea analizar. Entonces, dependiendo 

de la geometría a discretizar, se cuenta con diferentes elementos: Concentrados (Point 

Elements), Unidimensionales (Line Elements), Bidimensionales (Area Elements) y 

Tridimensionales (Volume Elements). La creación de los modelos geométricos será 

efectuada en dos dimensiones, entonces es importante prestar atención a los elementos 

bidimensionales.  
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La Figura 2.3 ilustra el elemento cuadrilátero PLANE2D, el cual es un sólido plano de 4 u 

8 nodos que realiza análisis de tensión plana, deformación plana y de sólidos 

axisimétricos de revolución. Para la tarea de modelación del estudio de fractura se 

utilizará el PLANE2D de 8 nodos (elemento de segundo orden o parabólico), ya que la 

recomendación del propio COSMOS/M señala que este elemento es adecuado para la 

modelación de problemas estructurales y de fractura [8]. Es importante hacer hincapié en 

que un elemento cuadrilátero brinda la posibilidad de realizar un enmallado de forma 

controlada por el usuario, definiendo una determinada cantidad de elementos por arista. 

Fig. 2.3. Elemento PLANE2D de 4 y 8 nodos. 

La caracterización de la tenacidad a la fractura de un espécimen fue realizada mediante 

los resultados del factor de intensidad de tensiones y la J -Integral. Cada espécimen fue 

analizado atendiendo a sus cuatro variantes producto de los diferentes tamaños de fisura 

(5, 10, 20 y 50 mm). A su vez, para cada variante se realizaron diferentes modelaciones, 

ya que la malla fue afinada más de una vez con el objetivo de alcanzar la precisión 

adecuada y de esta forma lograr los mejores resultados de K . Una vez alcanzada la 

precisión deseada bajo una malla determinada, se utilizó ésta para la caracterización de la 

fractura mediante la evaluación de la J -Integral. Entonces, sobre la malla que ofreció los 

mejores resultados de K  para una variante determinada, se definieron diferentes 

contornos J  alrededor de la cabeza de la fisura con el objetivo de lograr la convergencia 

y obtener los mejores valores para una J -Integral elasto-lineal. 

Para dar cumplimiento a la tarea de afinar la malla de un modelo, se definió una relación 

entre el tamaño de la fisura y el número de elementos contenidos en ésta. Si la longitud 

de fisura analizada ( a ) es igual a la longitud de uno de los lados del elemento que 

conforma el enmallado, la malla fue denominada como malla 1. Si la longitud a  contiene 

exactamente a dos lados de dos elementos contiguos, se obtiene una malla 2, y si a  
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contiene tres lados se genera una malla 3, y así sucesivamente se van obteniendo mallas 

cada vez más finas que las anteriores. 

Después de desarrollar aspectos como el modelo idealizado, el modelo geométrico, las 

condiciones de contorno y el enmallado, es importante ilustrar cómo el programa 

COSMOS/M logra agrupar estos conceptos en un análisis de fractura. Por ejemplo, la 

Figura 2.4 ilustra al modelo geométrico del espécimen CCT con un tamaño de fisura de 

100 mm ( a =50 mm), el cual fue enmallado por 8, 32 y 72 elementos generando tres tipos 

de malla (1, 2 y 3). La carga distribuida σ  igual a 100MPa fue aplicada en el borde 

opuesto al que contiene la fisura y es graficada de color violeta. De igual forma las 

restricciones UX y UY son aplicadas en los bordes coincidentes con los planos de simetría 

y son graficadas de color rojo, y finalmente el segmento de borde libre de restricciones 

representa la fisura contenida en el espécimen.  

a) b) c) 

Fig. 2.4. CCT a =50 mm y sus respectivas condiciones de contorno. a) malla 1 

conformada por 8 elementos, b) malla 2 conformada por 32 elementos y c) malla 3 

conformada por 72 elementos que contiene 6 trayectorias J -Integral. 
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El programa necesita reconocer la cabeza de la fisura y la dirección de propagación, lo 

cual se logra seleccionando un primer nodo que representa la cabeza y un segundo nodo 

que, junto con del primero genera una línea recta imaginaria que representa la dirección 

de la propagación. La caracterización de la fractura elasto-lineal a través de la J -Integral 

para la misma variante, CCT a =50 mm, se logra evaluando el modelo con la malla tipo 3 

definiendo seis contornos de trayectorias diferentes alrededor de la cabeza de la fisura 

para determinar cuál de ellas arroja los mejores resultados. 

El programa necesita reconocer ciertas propiedades del material que se está sometiendo 

al análisis. Las propiedades que necesitan ser definidas para el estudio de fractura 

elástico lineal son el módulo de elasticidad y el coeficiente de Poisson. Los valores 

asignados a las propiedades de los tres especimenes son iguales y pueden ser 

apreciadas en la Tabla 2.1, éstas corresponden al acero. 

Tabla. 2.1. Propiedades asignadas a los modelos CCT, DENT y SENT. 

Propiedades CCT DENT SENT 

Módulo de elasticidad E  )/( 2mN 0.21x1012 

Coeficiente de Poisson ν  0.28 

2.4. Validación de los resultados de la modelación del comportamiento de la fisura. 

El K  describe las condiciones presentes en la cabeza de la fisura en función de los 

esfuerzos, la configuración geométrica del espécimen y el tamaño de la fisura; así es que 

K  es una propiedad bajo ciertas condiciones. La influencia directa del tamaño de la 

discontinuidad sobre K  motivó la necesidad de apreciar la tendencia de los resultados 

ante el incremento de la longitud de la fisura, y la imposibilidad de afirmar a priori cuál es 

la densidad de malla adecuada, generó una variable más al estudio. Los resultados de la 

modelación fueron alcanzados a través de diferentes modelaciones, variando el tamaño 

de fisura y la densidad de la malla. El estudio del espécimen CCT produjo doce 

resultados, tres modelaciones por cada uno de los cuatro diferentes tamaños de fisura. 

Los estudios de DENT y SENT generaron cada uno dieciséis resultados, cuatro 
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modelaciones por cada tamaño de fisura, el porqué de la diferencia en el número de 

modelaciones entre los estudios será explicado más adelante. 

La validación de los resultados de la modelación se resolvió comparando los K  obtenidos 

con los resultados analíticos de diferentes autores. Se recurrió a la bibliografía de “The 

Stress Analysis of Cracks Handbook”[21] de Hiroshi Tada, la cual es una colección de 

trabajos que proponen soluciones revisadas y comprobadas cuidadosamente de K  para 

diferentes configuraciones estructurales. Dentro de este compendio se encuentran los tres 

especimenes en estudio, debidamente analizados y cuentan con más de una formulación 

analítica diferente para su evaluación. Las dos formulaciones analíticas más recientes de 

cada espécimen fueron seleccionadas para realizar la validación, ya que por ser últimas 

se puede presumir que contaron con mayores recursos para su elaboración comparadas 

con sus antecesoras. A continuación se mencionan las expresiones analíticas 

seleccionadas como referentes para la validación de este trabajo. Tada plantea 

modificaciones a las formulaciones de Feddersen y Koiter para definir el K  de un 

espécimen CCT. Al igual que para el CCT, Tada modifica las fórmulas de Benthem e Irwin 

para determinar el K  para un espécimen DENT y para el espécimen SENT, Tada elaboró 

dos diferentes formulaciones. El factor de intensidad de tensiones para los especimenes 

es evaluado de acuerdo a la expresión (1.17): ( )baFaKI πσ= donde el factor 

adimensional ( )baF  tiene diferentes expresiones dependiendo del autor y del espécimen

en estudio. 

El Factor ( )baF  expresado para el espécimen CCT.

Formulación modificada de Feddersen (Tada1973): 

( ) ( ) ( )( )
b
abababaF
.2

.
sec06.0025.01 42 π

+−= (2.1) 

Donde la precisión es de 0.1% para cualquier ba . 

Formulación modifica de Koiter (Tada1973): 

( ) ( ) ( ) ( )
( )ba

babababaF
−

−+−
=

1

044.0370.05.01 32

(2.2) 

Donde la precisión es de 0.3% para cualquier ba . 
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El Factor ( )baF  expresado para el espécimen DENT.

Formulación modificada de Benthem (Tada1973): 

( ) ( ) ( ) ( )
( )ba

bababababaF
−

−+−−
=

1

)/(190.0471.0205.0561.0122.1 432

  (2.3) 

Donde la precisión es de 0.5% para cualquier ba  

Formulación modifica de Irwin (Tada1973): 

( )
b
a

a
b

b
abaF

.2

.
tan

.

.2

.2

.
cos122.01 4 π

π
π







 +=   (2.4) 

Donde la precisión es 0.5% para cualquier ba

El Factor ( )baF  expresado para el espécimen SENT.

Formulación de Tada (1973): 

( )
( )

b
a

b
aba

b
a

a
bbaF

.2

.
cos

.2

.
sin137.002.2752.0

.
.2

.
tan

.

.2

3

π

π
π

π







 −++

=

     (2.5) 

Donde la precisión es mayor al 0.5% para cualquier ba  

Formulación de Tada (1973): 

( ) ( )( ) ( )
( )( ) 2/3

4

1

265.0857.0
1265.0

ba
bababaF

−
+

+−=   (2.6) 

Donde la precisión es mayor al 1% para 2.0<ba  y al 0.5% 

para 2.0≥ba  

Antes de realizar la comparación entre los resultados analíticos y los de la modelación, se 

pensó que era conveniente contrastar en primer lugar, los valores proporcionados por las 

expresiones analíticas. Se pudo observar que los valores eran muy parecidos llegando a 
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concluir que se podría prescindir de una de las dos referencias. Por ejemplo, los 

resultados obtenidos de las ecuaciones (2.1) y (2.2) del espécimen CCT permitieron 

escoger a la expresión (2.1), ya que la diferencia es muy pequeña como puede ser 

apreciada en la Tabla 2.2 y en la Figura 2.5. La Figura 2.5 ilustra un diagrama K  versus 

a  donde las dos curvas generadas con los valores calculados de las expresiones (2.1) y 

(2.2) presentan una tendencia idéntica a medida que la fisura se incrementa. Después de 

contrastar los valores arrojados por las referencias de los tres especimenes, una nueva 

selección condujo a la designación de las ecuaciones (2.1), (2.3) y (2.5), como las 

referencias definitivas para la validación de los resultados de la modelación. 

Tabla 2.2. Resultados analíticos de K  del espécimen CCT cuando el tamaño de la fisura 

incrementa 

CCT 

Fisura Factor de intensidad de tensiones K  (Nm-3/2) 

a  (mm) Expresión (2.21) Expresión (2.22) 

5 12.5517x106 12.5491X106 

10 17.8303x106 17.8174X106 

20 25.6799x106 25.6274X106 

30 47.0143 x106 46.9138 X106 
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Fig. 2.5. Evaluación del comportamiento de una fisura para el espécimen CCT bajo las 

expresiones analíticas (2.1) y (2.2). 
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Se describirá la metodología de validación practicada a una de las variables (CCT a =50 

mm) para que de esta forma quede plasmado los pasos seguidos para conseguir los

valores adecuados de la modelación. Las curvas )(afK =  generadas por los valores

analíticos procedentes de la expresión (2.1) y por los valores proporcionados por el

programa, presentan el incremento del factor K  a medida que la longitud de la fisura

crece (ver Figura 2.6).

Mientras que se cuenta con una curva analítica, existen tres curvas que son el resultado 

de la modelación del espécimen bajo tres diferentes mallas, y todas ellas manifiestan 

tendencias similares. Si se compara la curva - malla 1 con la curva de la referencia se 

puede observar que existe una pequeña diferencia, la cual se hace cada vez más 

estrecha a medida que la malla del espécimen es afinada, hasta conseguir los mejores 

resultados con la tercera malla; porque no sólo la tendencia de la curva es la misma, sino 

que la diferencia entre los valores es tan pequeña que da la impresión de tener curvas 

sobre puestas. Una inspección rápida de las gráficas de la Figura 2.6 revela lo que para 

cualquier tamaño de fisura, la malla 3 entrega los mejores resultados y la Tabla 2.3 

cuantifica el error existente entre los valores de la modelación y los analíticos. 

Tabla. 2.3. Comparación de los K obtenidos por software - malla 3, con los K  de la 
referencia para el modelo CCT  

CCT – Malla 3 

Fisura Factor de intensidad de tensiones Error 

a
( mm ) 

MCOSMOSK /

( -3/2mN )
)1.2(.EXPK

( -3/2mN ) 
REF

REFMCOSMOS

K
KK −/

( % ) 

5 12.5517x106 12.5526x106 0.01 

10 17.8303x106 17.8358x106 0.03 

20 25.6799x106 25.6853x106 0.03 

50 46.962x106 47.0143x106 -0.11
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Fig. 2.6. Curvas del espécimen CCT, obtenidas a partir de los valores analíticos y de los 

resultados de COSMOS/M. a) Malla 1, b) Malla 2 y c) Malla 3. 
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La validación de los resultados de los especimenes DENT y SENT es efectuada con el 

mismo procedimiento descrito para el espécimen CCT. La tendencia de las curvas arrojadas 

por los resultados de la modelación y los valores analíticos describen el mismo 

comportamiento, pero a diferencia del CCT, las curvas que están más cerca de la curva de 

referencia son las generadas por la malla 2, es decir ambos especimenes encontraron los 

errores más bajos cuando dos elementos están contenidos a lo largo de la longitud de la 

fisura. Cabe mencionar que los resultados de la modelación bajo una malla 1 produjeron los 

mayores errores, para una segunda malla de tipo 2 se encontraron los menores errores, ya 

que al generar mallas de tipo 3 y 4 los errores se incrementaron pero sin alcanzar los valores 

de la primera malla. La Figura 2.7 ilustra las curvas de modelación más próximas a las 

curvas de referencia de los especimenes DENT y SENT. Las Tablas 2.4 y 2.5 dan 

información que posibilita comparar los valores de la modelación bajo una malla 2 y los 

valores calculados gracias a las expresiones de referencias. 
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Fig. 2.7. a) Curvas del espécimen DENT, obtenidas a partir de los valores analíticos y de los 

resultados de COSMOS/M. b) Curvas del espécimen SENT obtenidas a partir de los valores 

analíticos y de los resultados de COSMOS/M. 
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Tabla. 2.4. Comparación de los K obtenidos del software bajo una malla 2 con los de la 

referencia para el modelo DENT  

 

DENT – Malla 2 

Fisura  Factor de intensidad de tensiones Error 

a  
( mm ) 

MCOSMOSK /  

( -3/2mN ) 

)3.2(.EXPK  

( -3/2mN ) 
REF

REFMCOSMOS

K
KK −/

(%) 

5 13.738x106 14.0610x106 -2.30 

10 19.3771x106 19.8847x106 -2.55 

20 27.3100x106 28.1669x106 -3.04 

50 45.8597x106 46.9278x106 -2.28 

 

 

Tabla. 2.5. Comparación de los K obtenidos del software bajo una malla 2 con los de la 

referencia para el modelo SENT  

 

SENT – Malla 2 

Fisura  Factor de intensidad de tensiones Error 

a  
( mm ) 

MCOSMOSK /  

( -3/2mN ) 

)5.2(.EXPK  

( -3/2mN ) 
REF

REFMCOSMOS

K
KK −/

(%) 

5 13.8151x106 14.2443x106 -3.01 

10 19.7688x106 20.335 x106 -2.78 

20 29.1369x106 30.296x106 -3.83 

50 57.1914x106 59.6593x106 -3.99 

 

Los especimenes modelados anteriormente pueden ser analizados utilizando la J -

Integral, caracterizando su tenacidad a la fractura, ya que la J  puede ser evaluada para 

materiales elasto-lineales como para elasto-plásticos. Los resultados J  obtenidos de la 

modelación son expresados en sus equivalentes K  mediante las ecuaciones (1.21) y 
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(1.22) desarrolladas en el capítulo uno para realizar la validación, comparándolos con los 

valores obtenidos de las expresiones (2.1), (2.2) y (2.3). Se tomaron las mallas de los 

especimenes que generaban los menores errores y sobre éstas se definieron contornos 

alrededor de la cabeza de la fisura, por ejemplo el espécimen CCT con un tamaño de 

fisura a=50 mm y una malla del tipo 3, que puede ser apreciado en la Figura 2.8, fue 

analizado bajo 6 trayectorias diferentes, de las cuales la quinta obtuvo los errores más 

bajos. Al igual que para a=50 mm, los demás tamaños de fisura encontraron los mejores 

resultados en la 5J , lo cual puede ser apreciado en la Figura 2.9 y en la Tabla 2.6. 

 
 

 
 
 

 

Fig. 2.8. CCT a=50mm bajo un tipo de malla 3 que alberga a 6 trayectorias J -Integral. 
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Fig. 2.9. Curvas del espécimen CCT obtenidas a partir de los valores analíticos (2.3) y de 

los resultados de 5J  del COSMOS/M. 
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Tabla 2.6. Resultados de la J  mediante la modelación por elementos finitos. Espécimen 
CCT evaluado bajo la trayectoria 5. 

 

CCT – Malla 3 – J 5 

Fisura  COSMOS/M Referencia Error 

a  
( mm ) 

5J  

( -1mN ) 

K  
( -3/2mN ) 

)1.2(.EXPK  

( -3/2mN ) 
REF

REFMCOSMOS

K
KK −/

(%) 

5 756.99 12.608 x106 12.5526x106 0.45 

10 1527.6 17.91 x106 17.8358x106 0.45 

20 3168.6 25.796 x106 25.6853x106 0.45 

50 10582.0 47.141x106 47.0143x106 0.27 

 

El tratamiento que se practicó a los resultados J -Integral del espécimen CCT, volvió a ser 

tomado para la evaluación de los valores entregados por el software de los especimenes 

DENT y SENT. A diferencia del espécimen CCT, los especimenes DENT y SENT obtuvieron 

los mejores resultados cuando se vieron evaluados por 3J , como se puede apreciar en la 

Figura 2.10. 
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Fig. 2.10. a) DENT: Curvas obtenidas a partir de los valores analíticos y de los resultados de 

COSMOS/M. b) SENT: Curvas generadas a  partir de los valores analíticos y de los 

resultados de COSMOS/M. 

 44 



Las Tablas 2.7 y 2.8 ofrecen un resumen de los mejores resultados alcanzados con la 

trayectoria tres para cada tamaño de fisura de los especimenes SENT y DENT. Las 

gráficas ilustran la tendencia de las curvas y la convergencia de los resultados y las tablas 

cuantifican el error existente entre los valores analíticos y los de la modelación. 

 

Tabla 2.7. Resultados de J  mediante la modelación por elementos finitos. Espécimen 
DENT evaluado bajo la trayectoria 3. 

 

DENT – Malla 2 – J 3 

Fisura  COSMOS/M Referencia Error 

a  
( mm ) 

3J  

( -1mN ) 
K  

( -3/2mN ) 
)3.2(.EXPK  

( -3/2mN ) 
REF

REFMCOSMOS

K
KK −/

(%) 

5 957.28 14.178x106 14.0610x106 0.83 

10 1903.9 19.995x106 19.8847x106 0.55 

20 3774.4 28.153x106 28.1669x106 -0.05 

50 10424.0 46.787x106 46.9278x106 -0.30 

 
Tabla 2.8. Resultados de J  mediante la modelación por elementos finitos. Espécimen 

DENT evaluado bajo la trayectoria 3. 
 

SENT – Malla 2 – J 3 

Fisura  COSMOS/M Referencia Error 

a  
(mm) 

3J  

( -1mN ) 

K  
( -3/2mN ) 

)5.2(.EXPK  

( -3/2mN ) 
REF

REFMCOSMOS

K
KK −/

(%) 

5 957.28 14.259x106 14.2443x106 0.10 

10 1982.9 20.406x106 20.335x106 0.35 

20 4315.4 30.104x106 30.296x106 -0.63 

50 17088 59.903x106 59.6593x106 0.41 

 

 45 



CAPÍTULO III 
 

MODELACIÓN DE FISURAS EN UNIONES SOLDADAS POR ELEMENTOS FINITOS. 
 

3.1. Introducción. 
 

La experiencia adquirida de las modelaciones anteriores es volcada en un nuevo estudio, 

donde se analizará  una fisura en una unión soldada de filete. La fisura contenida en la 

unión es de tipo superficial semi-elíptica que exige un modelo tridimensional, dividiendo el 

estudio en dos partes. La primera parte consiste en validar los resultados de la 

modelación de una fisura superficial semi-elíptica en una plancha plana con valores 

analíticos, ya que es necesario manejar una buena metodología antes de realizar la 

modelación de un componente más complejo. La segunda parte consiste en incorporar la 

fisura modelada de la primera parte a un estudio donde se analice el comportamiento de 

ésta en una unión soldada de filete, y al igual que la modelación de los especimenes, los 

resultados de ambas partes serán comparados con valores analíticos. 

 

3.2. Particularidades de una unión soldada a considerar en la modelación de 
fisuras. 

 

Un primer intento por definir la particularidad de la unión soldada para el trabajo de 

modelación consistió en tratar de diferenciar las propiedades del material base y de la 

unión soldada. Este análisis es descrito  continuación. 

 

El proceso de soldadura tiene la finalidad de dar continuidad a un material, pero la propia 

naturaleza de la soldadura indica que ya de por sí es una discontinuidad. A pesar de esto, 

se trata en lo posible que el material base y el cordón de soldadura se comporten como 

un material homogéneo para lo cual la selección del material de aporte de la mayoría de 

procesos tiene una especial atención en empatar las propiedades de la unión soldada. 

 

El electrodo revestido de un proceso de soldadura SMAW tiene un alma de composición 

normalmente igual al material base, es por ello que las propiedades del material base y el 

cordón de soldadura son parecidas. Bajo un enfoque ingenieril se puede considerar que 

propiedades como el módulo de elasticidad y el coeficiente de Poisson son muy parecidos 

e incluso iguales, y justamente estas dos propiedades son información indispensable para 
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el análisis de fractura elástico lineal. Esto quiere decir que si el material base y la unión 

soldada tuvieran los mismos valores de módulo de elasticidad y coeficiente de Poisson, la 

caracterización mediante K  no encontraría diferencia alguna entre los dos. 

 

Por lo general es posible encontrar diferencias entre el cordón de soldadura y el material 

base si investigamos sus propiedades mecánicas. El esfuerzo de fluencia de ambos será 

diferente pero esta propiedad es relevante en un análisis elástico plástico más no en uno 

elástico lineal. Por ello el intento de particularizar la modelación de una unión soldada, 

basados en diferenciar las propiedades mecánicas del material, no prosperó. 

 

Después de estudiar las posibles particularidades que podrían ser incluidas en la 

modelación, se apostó por el factor geométrico, cuya influencia sobre la caracterización 

de la fractura elasto-lineal sería muy interesante de estudiar. Se buscó un tipo de unión 

que además de contar con una particular geometría, debería ser muy utilizado en 

componentes soldados y contar con formulaciones analíticas para validar los resultados 

de la modelación. La unión soldada de filete fue seleccionada porque desde el punto de 

vista geométrico tiene cierto grado de complejidad y quizás después de la unión a tope 

sea la más utilizada en la industria. Cabe mencionar que la norma API RP 579 – “Fitness 

for service” proporciona expresiones matemáticas para enfrentar el problema de fractura 

en una unión de filete, haciendo de este modo viable la tarea de validación. 

 

3.3. Modelación de la fisura semi elíptica con el software Cosmos/M. 
 

3.3.1. Modelación de una fisura semi elíptica. 
 

Se ha realizado la modelación de una plancha de acero que contiene una fisura superficial 

semi-elíptica para determinar el factor K . La plancha en estudio está sometida a campos 

de esfuerzos de membrana y de flexión, los cuales están aplicados en los extremos de la 

misma (ver Figura 3.1-a). La fisura está localizada en la parte media de la plancha y son 

dos puntos los que se necesitan evaluar, uno ubicado en el extremo vertical y el otro en el 

extremo horizontal de la fisura, por ello para un determinado tamaño de fisura se 

obtendrán dos resultados de K . La Figura 3.1-a ilustra a la plancha plana sometida a los 

campos de esfuerzo y la Figura 3.1-b es una vista seccionada de la plancha donde se 

pueden apreciar los puntos A  y B , los cuales serán de especial interés en la obtención 
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de resultados, ya que son los puntos críticos en las dos direcciones de propagación de la 

fisura. 

 
Fig. 3.1-a. Fisura superficial semi-elíptica sobre plancha de acero (vista isométrica). 

 
Fig. 3.1-b. Fisura superficial semi-elíptica sobre plancha de acero (vista en sección). 

 

Para evaluar el comportamiento de la fisura se analizaron diferentes variantes atendiendo 

a diferentes tamaños de ésta, manteniendo iguales las dimensiones de la plancha para 

las diversas modelaciones. El semieje mayor ( c ) de la fisura se encuentra sobre una de 

las caras libres de la plancha y el semieje menor ( a ) está oculto en el interior de la 

misma, como lo ilustra la Figura 3.1-a y 3.1-b. El parámetro “ a ” que registra cuan 

profunda es la fisura se ve incrementado desde los 3 mm hasta los 8 mm. El parámetro 

“ c ” que mide la longitud de la fisura se incrementa desde los 7,5 mm hasta los 20 mm. El 

parámetro “ t ” que representa al espesor es igual a 10 mm, los parámetros “ w ” y “ h ” 

representan la mitad del ancho y largo, cuyos valores son iguales a 50 mm. Con respecto 

a las propiedades del material de la plancha el módulo de elasticidad es 0.21x1012 N/m2 y 
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el coeficiente de Poisson es 0.28. El esfuerzo de membrana mσ  es igual a 100 MPa y el 

de flexión bσ  es 30 MPa, los cuales se mantuvieron constantes a lo largo de todos los 

ensayos. 

 

Los modelos definidos para el análisis son una cuarta parte de la configuración 

geométrica original, debido a la existencia de una doble simetría. La malla usada en el 

análisis es mostrada en la Figura 3.2, y se tuvo un especial cuidado en definir los 

elementos que rodean la fisura. El elemento utilizado es SOLID 3D de 20 nodos el cual 

puede ser generado a partir de la operación de extrusión de un elemento PLANE2D de 8 

nodos (ver sección 3.5). 

 
 

Fig. 3.2. Modelo de plancha con fisura superficial semi-elíptica y sus condiciones de 

contorno. 

 

La Figura 3.2 ilustra las condiciones de contorno que son definidas sobre el modelo 

geométrico creado en el propio ambiente del COSMOS/M. Las restricciones son 

impuestas sobre las caras que coinciden con los planos de simetría, dejando libre las 

superficies que representan la cara de la fisura. Sobre estas mismas superficies el 

enmallado adquirió una especial dedicación con la finalidad de encontrar la malla que 

genere los resultados adecuados de K  en los puntos A  y B . Las cargas son aplicadas 

sobre una de las caras del modelo de forma tal que el comportamiento de éste es el 

esperado. 
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3.3.2. Validación de los resultados de una fisura semi elíptica 
 

Se efectuaron diferentes modelaciones variando el tamaño de la fisura. Los primeros 

ensayos mantuvieron el parámetro “ c ” constante con un valor igual a 10 mm y el 

parámetro “ a ” tomó diferentes valores entre 3 mm y 8 mm. Los segundos ensayos, 

mantuvieron constante a “ a ” con un valor igual a 5 mm y los valores de “ c ” se 

incrementaron desde 7,5 hasta 20 mm. Como se mencionó anteriormente, se extrajeron 

los resultados de dos puntos diferentes por modelación, uno ubicado en el extremo 

horizontal “ A ” y el otro en el extremo vertical “ B ”. Es preciso resaltar que sobre los 

puntos “ A ” y “ B ” se presentan los mayores esfuerzos como lo ilustra la Figura 3.3. 

 

La validación de la metodología de modelación fue hecha comparando los K  de las 

diferentes modelaciones con resultados analíticos obtenidos de la norma API RP 579 – 

“Fitness for service”. 

 

 
 

Fig. 3.3. Resultados de la modelación de plancha con fisura superficial semi-elíptica. 
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Los resultados numéricos de la modelación y de la parte analítica son mostrados a 

continuación en las Tablas 3.1 y 3.2, mientras que los gráficos de las Figuras 3.4 y 3.5 

ilustran la tendencia que manifiestan los puntos “A” y “B” cuando el tamaño de la fisura 

crece vertical y horizontalmente. 

 

 
 

 
  

a)      b) 
Fig. 3.4. Curvas de comportamiento punto “ A ” de fisura superficial semi-elíptica. 

a) Cuando crece verticalmente, b) Cuando crece horizontalmente. 

 

Tabla 3.1. Resultados numéricos punto “ A ” de fisura superficial semi-elíptica. 

Punto A ( °= 0ϕ )  Punto A ( °= 0ϕ ) 
a  c  API RP 579 COSMOS/M Error  a  c  API RP 579 COSMOS/M Error 

)(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%)  )(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%) 

3 10 268,500 266,538 -0,7  5 7,5 426,288 443,987 4,2 
4 10 352,691 352,611 0,0  5 10 430,789 434,279 0,8 
5 10 430,789 434,279 0,8  5 12,5 428,402 432,065 0,9 
6 10 501,372 505,674 0,9  5 15 423,919 429,940 1,4 
7 10 563,654 566,390 0,5  5 17,5 419,312 423,551 1,0 
8 10 617,578 643,341 4,2  5 20 415,479 414,725 -0,2 

Tabla 3.2. Resultados numéricos punto “ B ” de fisura superficial semi-elíptica. 

Punto B ( °= 90ϕ )  Punto B ( °= 90ϕ ) 
a  c  API RP 579 COSMOS/M Error  a  c  API RP 579 COSMOS/M Error 

)(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%)  )(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%) 

3 10 407,767 409,750 0,5  5 7,5 392,993 383,280 -2,5 
4 10 443,890 440,799 -0,7  5 10 460,468 452,833 -1,7 
5 10 460,468 452,833 -1,7  5 12,5 513,494 507,865 -1,1 
6 10 460,962 445,568 -3,3  5 15 557,780 559,010 0,2 
7 10 448,676 423,792 -5,5  5 17,5 596,760 591,965 -0,8 
8 10 426,953 392,790 -8,0  5 20 632,676 642,353 1,5 
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a)      b) 

Fig. 3.5. Curvas de comportamiento punto “ B ” de fisura superficial semi-elíptica. 

a) Cuando crece verticalmente, b) Cuando crece horizontalmente. 

 

 

3.4. Modelación de la fisura en uniones soldadas con el software COSMOS/M. 
 

3.4.1. Modelación de una fisura en una unión de filete. 
 

Al igual que en el estudio anterior, se ha realizado la modelación de una fisura superficial 

semi-elíptica, con la particularidad de que en este nuevo estudio la fisura está sobre una 

unión soldada de filete. La fisura nuevamente está sometida a campos de esfuerzos de 

membrana y de flexión, y se realizan diferentes modelaciones atendiendo a su tamaño. 

 

El tamaño de la fisura tomó diferentes dimensiones, ya que los parámetros “ a ” y “ c ” se 

incrementan de 3 mm a 8 mm y de 7.5 mm a 20 mm respectivamente. Las dimensiones 

de la plancha se mantienen: “ t ” es igual a 10 mm, “ w ” es igual a 50 mm y “ h ” es igual a 

40 mm. Las propiedades de los materiales son: módulo de elasticidad igual a 0.21x1012 

N/m2 y coeficiente de Poisson igual a 0.28. El esfuerzo de membrana mσ  es igual a 100 

MPa y el esfuerzo de flexión bσ  es igual a 30 MPa. Los nuevos parámetros a considerar 

son: la longitud “ L ” igual a 20 mm, el radio “ r ” igual a 0.07 mm y el ángulo “α ” igual a 

45º (ver Figura 3.6-a y 3.6-b). Todos estos nuevos parámetros se mantuvieron constantes 

a lo largo del trabajo de modelación. 
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Fig. 3.6-a. Fisura superficial semi-elíptica en unión soldada de filete (vista isométrica). 

 

 

 
 

 
Fig. 3.6-b. Fisura superficial semi-elíptica en unión soldada de filete (vistas lateral y en 

sección). 
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El modelo definido para el análisis resultó ser la mitad de la configuración geométrica 

original ya que solo se contaba con un plano de simetría. Las condiciones de contorno 

son definidas con el mismo criterio que se utilizó en el estudio de la plancha (ver Figura 

3.7). Las restricciones son impuestas sobre la cara que coinciden con el plano de 

simetría. Las cargas son aplicadas adecuadamente sobre los extremos del modelo. 

 
Fig. 3.7. Modelo idealizado de la unión soldada de filete con fisura superficial semi-elíptica 

y sus condiciones de contorno. 

 

Se utilizó el elemento SOLID 3D de 20 nodos y el enmallado quedó definido como lo 

ilustra la Figura 3.8. 

 
Fig. 3.8. Modelo generado en COSMOS/M del modelo idealizado. 
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3.4.2. Validación de los resultados de una fisura en una unión de filete. 
 

El tratamiento de la fisura fue igual que el empleado en el estudio anterior, donde se 

evaluó su comportamiento ante el cambio dimensional al que fue sometida. La Figura 3.9 

muestra el resultado de la modelación de una fisura superficial semi-elíptica en una unión 

soldada de filete. Al igual que en la plancha, los puntos “A” y “B” concentran los mayores 

esfuerzos. 

 

  
Fig. 3.9. Modelación de fisura superficial semi-elíptica en unión soldada de filete. 
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La validación de los K  obtenidos de la modelación fue hecha comparándolos con los 

resultados analíticos de la norma API RP 579 – “Fitness for service”. Un resumen de los 

resultados obtenidos de la modelación y de los cálculos analíticos son mostrados a 

continuación en las Tablas 3.3 y 3.4, mientras que los gráficos de las Figuras 3.10 y 3.11 

ilustran la tendencia que genera el incremento de tamaño de la fisura en los puntos “A” y 

“B”. 

 
  

 
 

 
a)      b) 

Fig. 3.10. Curvas de comportamiento punto “ A ” de fisura superficial semi-elíptica en una 

unión de filete. 

a) Cuando crece verticalmente, b) Cuando crece horizontalmente. 

 

 

 

 

 

Tabla 3.3. Resultados numéricos punto “ A ” de fisura semi-elíptica en unión de filete. 

Punto A ( °= 0ϕ )  Punto A ( °= 0ϕ ) 
a  c  API RP 579 COSMOS/M Error  a  c  API RP 579 COSMOS/M Error 

)(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%)  )(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%) 

3 10 419,600 277,682 -33,8  5 7,5 661,773 393,464 -40,5 
4 10 544,013 337,268 -38,0  5 10 666,322 452,453 -32,1 
5 10 666,322 402,453 -39,6  5 12,5 638,637 451,052 -29,4 
6 10 788,104 438,722 -44,3  5 15 617,329 441,151 -28,5 
7 10 909,346 494,577 -45,6  5 17,5 601,252 419,792 -30,2 
8 10 1027,708 542,252 -47,2  5 20 589,614 422,524 -28,3 
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a)       b) 

Fig. 3.11. Curvas de comportamiento punto “ B ” de fisura superficial semi-elíptica en una 

unión de filete. 

a) Cuando crece verticalmente, b) Cuando crece horizontalmente. 

 

 

Al observar las curvas generadas, se puede deducir que el error entre ellas no son 

despreciables, pero la tendencia de las curvas de los resultados de la modelación 

responden de forma muy parecida a la tendencia de los valores analíticos. Es posible que 

la norma API dentro de las expresiones analíticas considere un factor adicional con la 

finalidad de dar un margen de seguridad para la determinación de los valores de K . 

 

 

 

 

Tabla 3.4. Resultados numéricos punto “ B ” de fisura semi-elíptica en unión de filete. 

Punto B ( °= 90ϕ )  Punto B ( °= 90ϕ ) 
a  c  API RP 579 COSMOS/M Error  a  c  API RP 579 COSMOS/M Error 

)(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%)  )(mm  )(mm  )( 2/3−Nmm  )( 2/3−Nmm  (%) 

3 10 381,075 366,759 -3,8  5 7,5 369,082 346,198 -6,2 
4 10 415,744 389,717 -6,3  5 10 433,749 400,265 -7,7 
5 10 433,749 400,265 -7,7  5 12,5 484,391 449,552 -7,2 
6 10 438,957 404,761 -7,8  5 15 525,412 481,298 -8,4 
7 10 435,118 404,584 -7,0  5 17,5 563,932 516,505 -8,4 
8 10 425,214 399,880 -6,0  5 20 598,285 559,912 -6,4 
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3.5. Metodología para el estudio del comportamiento de fisuras en uniones 
soldadas usando software de Elementos Finitos. 
 

Se ofrece una metodología de modelación como una guía a seguir para un análisis de 

fractura elástico lineal mediante el programa COSMOS/M que trabaja con el método de 

los elementos finitos. 

 

1. Creación de la geometría: El modelo idealizado del problema que se desea analizar 

debe ser plasmado en un modelo geométrico creado en GEOSTAR o importado desde un 

sistema CAD mediante la opción Control > CAD_System. 

 

2. Definición del elemento finito: Es necesario definir un tipo de elemento y seleccionar 

sus características de acuerdo con el estudio que se desea practicar, y esto se consigue a 

través de la opción PropSets > Element Grupo. 

 

3. Definición de las propiedades del material: Es posible seleccionar un material de la 

librería del programa a través de la opción PropSets > Pick Material Lib o ingresar solo las 

propiedades que sean necesarias para el estudio mediante la opción PropSets > Material 

Property. 

 

4. Definición de la constante real: Cuando se realizan modelaciones en dos 

dimensiones, por ejemplo una plancha plana, el interés se centra en dos de sus 

dimensiones más representativas, a pesar de esto la tercera dimensión debe ser definida 

también; para el ejemplo de la plancha, el espesor debe ser definido como una constante 

real mediante la opción PropSets > Real Constant. 

 

5. Generación de la malla: La discretización del componente continuo consiste en 

dividirlo en los pequeños elementos finitos del tipo que se ha seleccionado previamente. 

Este conjunto de elementos finitos que conforman la geometría del componente le dan la 

apariencia que estuviera enmallado. Entonces cuando se refiere a la creación de la malla, 

no es otra cosa que la discretización del componete, lo cual se logra mediante la opción 

Meshing > Parametric_Mesh. 
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6. Mezclar y comprimir los nodos: En caso de que la malla es creada a partir de varias 

entidades geométricas que se unen entre sí, es posible considerar que en un mismo lugar 

coexistan más de un nodo, entonces es necesario utilizar la opción Meshing > Nodes > 

Merge para mezclar los nodos y Meshing > Nodes > Compress para comprimirlos. 

 

7. Definición de las condiciones de contorno: Mediante la opción LoadsBC es posible 

definir las restricciones y cargas para aplicarlas al modelo geométrico sobre los nodos, 

elementos, curvas, etc. que lo conforman. 

 

8. Definición de la fisura: Para lograr que el programa identifique la fisura se necesita 

una aproximación geométrica propia de una discontinuidad de este tipo y seleccionar dos 

o tres nodos de un mismo elemento cuya finalidad es representar a la fisura. El primer 

nodo representa la cabeza, el segundo con ayuda del primero definen la dirección de la 

propagación de la fisura y el tercero que conjuntamente con los dos anteriores define el 

plano de la fisura. Si se trabaja en un análisis en el plano (2D), bastará con definir a los 

dos primeros nodos, reservando al tercero para una modelación 3D. La opción necesaria 

para definir la fisura es Análisis > Static > Crack > Define crack. 

 

9. Realización del análisis: Un estudio de fractura puede ser resuelto con la opción 

Analysis > Static > Run > Static Analysis. 

 

10. Visualización de los resultados: A través de la opción Results se logran visualizar 

los resultados numéricos y gráficos de un problema analizado. 

 

11. Determinación de la propagación de la fisura del modelo: Para determinar la 

estabilidad o inestabilidad de la fisura de un componente es necesario comparar el IK  

con la tenacidad crítica o el factor de intensidad crítico del material ICK . El factor IK  

caracteriza la tenacidad a la fractura de un componente que posee una particular 

condición de trabajo, y está en función del tamaño de la fisura, la geometría del 

componente y la carga a la cual esta sometido. El ICK  es una propiedad del material 

determinado a partir de ensayos de laboratorio cuyos procedimientos son descritos por las 

normas como por ejemplo la ASTM E399-06 [9], la que es actualmente de aceptación 

general. El espécimen o probeta necesario para los ensayos cuenta con una geometría 
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estándar, por lo cual el ICK  depende del tamaño de fisura, la carga aplicada y el material 

de la probeta. La Tabla 3.5 proporciona valores de la tenacidad crítica de algunos aceros 

y aleaciones de aluminio. 

 
Tabla 3.5 Valores de ICK  de aceros y aleaciones Al-Cu 

 

Si al comparar resulta que IK es mayor que ICK , entonces es eminente la propagación 

inestable de la fisura bajo las condiciones en que se encuentre el componente en estudio, 

pero si por lo contrario IK es menor que ICK  es posible afirmar que no hay extensión de 

la fisura (estable) y el componente no fallará. 

 

A continuación se describen los pasos seguidos para alcanzar la evaluación de la 

tenacidad de fractura elasto-lineal ( K ) de una plancha plana fisurada, y de una unión en 

T que presentan una fisura. La metodología descrita anteriormente será aplicada para el 

trabajo de modelación de estos dos casos. 

 

 

 

 

 

 

 

 

 

Materiales Descripción 
Tenacidad 

ICK )( 2/3−mN  

AISI 1144 
Acero al carbono: Resulfurizado de fácil 

mecanizado. 
66x106 

AISI 4130 Acero aleado: Cr Mo. 110x106 

18Cr 8Ni Inoxidable Austenítico: AISI 304. 200x106 

1 ¼ Ni Cr Mo Acero aleado: AISI 43XX. 92x106 

18%Ni,8%Co,4%Mo Acero Marangig: Alta resistencia y tenacidad. 74x106 

2014-T651 Aleación Al-Cu: Estructuras para camión. 24x106 

2024-T351 Aleación Al-Cu: Estructuras para avión. 34x106 
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3.5.1. Caso 1: Determinación del factor de intensidad de tensiones del espécimen 
CCT. 
 

El problema consiste en determinar factor de intensidad de tensiones modo-I de fractura 

de una plancha plana de acero inoxidable austenítico 18Cr 8Ni que contiene una fisura en 

la parte central que atraviesa todo el espesor y está sometida a una carga distribuida 

remota. La Figura 3.12 brinda información dimensional del espécimen en estudio. 

 
Fig. 3.12. Plancha fisurada de acero 18Cr 8Ni. 

 

Consideraciones del caso 
La doble simetría del CCT genera un modelo que puede ser simplificado a un cuarto del 

tamaño original. Las propiedades del material son: módulo de elasticidad igual a 0.21x1012 

N/m2 y coeficiente de Poisson igual a 0.28. El enmallado del modelo deber ser tal que la 

fisura contenga a 3 elementos PLANE2D 8 nodos. 

 
Fig. 3.13. Modelo idealizado del caso 
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Vista y ejes de coordenadas 
Cambiar la vista para trabajar en el plano utilizando el icono View (Binocular) de Geo 

Panel y seleccionar la vista X-Y. 

 

Click en el icono View (Binocular) y seleccionar 
2D X-Y 

  

 
 Fig. 3.14. Icono View de Geo Panel. 

 

Geometría 
Crear cuatro puntos para generar cuatro curvas, las cuales a su vez delimitarán la 

superficie del modelo. 

 

Geo Panel: 

Geometry > Surfaces > Draw w/ 4 Coord 

 

Surface > 1 
XYZ-Coordinate of Keypoint 1 > 0,0,0 

XYZ-Coordinate of Keypoint 2 > 0.1,0,0 

XYZ-Coordinate of Keypoint 3 > 0.1,0.2,0 

XYZ-Coordinate of Keypoint 4 > 0,0.2,0 
 

Click en el icono Scale – Auto  

 
Fig. 3.15. Superficie generada por 4 

coordenadas. 
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Elemento finito 
Definir el elemento PLANE2D. 

 

Geo Panel: 

Propsets > Element Group 
 

Element Group > 1 

Element Name > PLANE2D 

 

Aceptar por defecto. 

 

 Fig. 3.16. Selección del elemento PLANE2D. 

 

Propiedades del material 
Definir las propiedades del material mencionadas anteriormente en Consideraciones del 

caso. 

 

Geo Panel: 

Propsets > Material Property 
 

Material set > 1 
Material Property Name > EX 
Property value > 0.21E12 

 

 Fig. 3.17. Definición del módulo de elasticidad. 

 

 

Material set > 1 
Material Property Name > NUXY 
Property value > 0.28 
 
 

 

 Fig. 3.18. Definición del coeficiente de Poisson. 
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Constante Real 
Definir el espesor de la plancha como una constante real. 

 

Geo Panel: 

Propsets > Real Constant 
 

Associated Element group > 1 
Real Constant set > 1 
Start loc. of the real const > 1 
No. of real const to be entered > 2 
RC1: Thickness > 0.01 

RC2: Material angle (Beta) > 0.0 

 

 Fig. 3.19. Definición del espesor. 

 

Enmallado 
Definir 6 elementos en la base y 12 elementos en la altura para dar cumplimiento a la 

tercer punto planteado en las Consideraciones del caso. 

 

Geo Panel: 

Meshing > Parametric Mesh > Surfaces 
 

Beginning surface > 1 

Ending surface > 1 

Increment > 1 

Number of nodes per element > 8 

Number of elements on the 1st curve > 6 

Number of elements on the 2nd curve > 12 

 

Aceptar por defecto.  

 
Fig. 3.20. Modelo enmallado por 

elementos PLANE2D 8 nodos. 
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Condiciones de contorno 
Etiquetar a cada curva del modelo para definir las condiciones de contorno (restricciones y 

cargas) sobre ellas. 

Geo Panel: 

Control > Active > Entity Label 
 

Entity > CR: Curve 
Number plotting flag > On: 1 
 

 
 Fig. 3.21. Curvas etiquetadas. 

 

Impedir el desplazamiento X e Y a lo largo de las curvas 4 y 5 respectivamente. 

 
Geo Panel 

LoadsBC > Structural > Displacement > Define 
by Curves 

Beginning Curve > 1 
Displacement Label > UY: Y translation 

Value > 0 
Ending Curve > 1 
Increment > 1 

 
Beginning Curve > 4 
Displacement Label > UX: X translation 
Value > 0 
Ending Curve > 4 
Increment > 1 

 

 Fig. 3.22. Restricciones del modelo 
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Definir la carga distribuida remota sobre la curva 2. 

Geo Panel 

LoadsBC > Structural > Pressure > Define by 
Curves 

Beginning Curve > 2 
Pressure magnitude > -100 

Ending Curve > 2 
Increment > 1 
Pressure at the end of direction 1 > -100 

Pressure Direction > 4: Normal Direction 

 

 
Fig. 3.23. Definición de la carga 

distribuida remota. 

 

Fisura 
Etiquetar los nodos de la malla para definir la fisura sobre el modelo creado. 

Geo Panel: 

Control > Active > Entity Label 
 

Entity > ND: Node 
Number plotting flag > On: 1 

 

 Fig. 3.24. Nodos etiquetados. 
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Seleccionar y liberar de restricciones a los nodos que están contenidos a lo largo de la 

fisura. 

Control > Select > by Lables 
 

Entity Name > ND: Node 
Beginning Entity > 8 
Ending Entity > 13 
Increment > 1 
Selection set number > 1 

 

 
Fig. 3.25. Selección de nodos contenidos 

en la fisura. 

 

LoadsBC > Structural > Displacement > 

Delete by Node 
 

Beginning Node > 1 
Displacement Label > UY: Y translation 

Ending Curve > NDMAX 
Increment > 1 

 

 Fig. 3.26. Fisura libre de restricciones. 

 

Definir la cabeza y la dirección de propagación de la fisura. 

 

Geo Panel: 

Analysis > Static > Crack > Define Crack 
Crack number > 1 

Node 1 > 7 

Node 2 > 9 
 

 Fig. 3.27. Nodos que definen a la fisura. 
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Análisis 
Analizar el caso bajo un estudio elástico lineal. 

 

Geo Panel: 

Analysis > Static > Run Static Analysis 

 

Resultados 
Visualizar los resultados gráficamente como un campo de esfuerzos resultantes (von 

Mises) de diferentes intensidades sobre el modelo distorsionado por la tensión aplicada. 

Geo Panel: 

 

Results > Plot > Stress 
 

Component > VON: von Mises stress 

Shape flag > 1: Deformed 
Deformed scale factor > 100 

 

 
Fig. 3.28. Esfuerzos Von Mises del 

modelo deformado bajo una escala 100. 

 

Buscar los resultados del factor de intensidad de tensiones que caracterizará la tenacidad 

de la fractura del caso analizado. 

 
Geo Panel: 

File > Edit file 
Filename > “name”.out  

CRACK STRESS INTENSITY FACTORS FOR CRACK 1 

(using displacement method) 

KI = 0.469620E+08 

 Fig. 3.29. K modo-I del espécimen CCT modelado. 
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Tabla 3.6. Valor de tenacidad crítica de un acero 18Cr 8Ni y IK  calculado por 

COSMOS/M. 

Material 
Tenacidad crítica COSMOS/M 

ICK )( 2/3−mN  IK )( 2/3−mN  
18Cr 8Ni 200x106 46.9x106 

 

Al comparar los resultados de la modelación con el valor de la tenacidad crítica de un 

acero 18Cr 8Ni (ver Tabla 3.6), se puede afirmar que la fisura contenida en la plancha del 

mismo tipo de acero, no se propagará bajo las condiciones a las que se encuentra 

sometida. Para hablar de una inestabilidad de la fisura, el valor de la tenacidad calculada 

por el programa debería por lo menos alcanzar el valor crítico de 200x106 Nm-3/2. 
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3.5.2. Caso 2: Determinación del factor de intensidad de tensiones de una fisura 
superficial semi-elíptica en una unión de filete. 
 

El caso puede ser descrito como una unión en filete con una típica fisura superficial 

ubicada entre el cordón de soldadura y el material base, sometida a un campo de 

esfuerzos de membrana mσ  igual a 100 MPa y a un campo de esfuerzos de flexión bσ  

igual a 30 MPa como se puede apreciar en la Figura 3.30-a. La forma semi-elíptica de la 

fisura ilustrada en la Figura 3.30-b, resulta ser una aproximación geométrica que 

responde de forma coherente con la realidad, proporcionando dos frentes de propagación 

en la direccio horizontal (punto A) y en la vertical (punto B). 

 
a) 

 
b) 

Fig. 3.30. Fisura superficial semi-elíptica en unión soldada de filete a) vista isométrica y b) 

vista en sección. 
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El material del cual están conformadas las planchas es un acero aleado AISI 4130 el cual 

posee un módulo de elasticidad igual a 0.21x1012 N/m2 y un coeficiente de Poisson igual a 

0.28. 

 

Consideraciones del caso 
La existencia de un plano de simetría genera la posibilidad la idealización cuyo tamaño es 

la mitad del original. 

 
Fig. 3.31. Modelo idealizado con sus respectivas cargas y restricciones a considerar. 

 

El modelo geométrico del modelo idealizado será llevado a cabo en tres partes como lo 

ilustra la Figura 3.32 y la malla de cada uno estará constituido por elementos sólidos 

(SOLID3D 20 nodos) resultado de la extrusión de PLANE2D 8 nodos. 

 
Fig. 3.32. Modelo geométrico dividido en tres etapas para su desarrollo. 
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Geometría – Parte I 
Cambiar la vista utilizando el icono View (Binocular) de Geo Panel y seleccionar la vista 

2D X-Y para dar inicio a la creación de la geometría del modelo. 

 

Crear los trece puntos, mediante la opción Geometry > Points > Define, ilustrados en la 

Figura 3.33 para conseguir generar 18 curvas, Geometry > Curves > Ellipse o Line with 2 

Pts, las cuales a su vez darán origen a 6 superficies, Geometry > Surfaces > Define by 3 ó 

4 Cr. La finalidad de dividir una superficie en otras es para obtener la posibilidad de un 

mejor manejo de la discretización ya que la definición de la fisura demanda un especial 

cuidado para obtener los mejores resultados. La curva 1 de la Figura 3.34 representa la 

cresta de la fisura y las superficies 1 y 6 de la Figura 3.35 representan la superficie de la 

fisura. 

 

Geo Panel: 

 

Geometry > Points > Define 

 

Keypoint > 1 
XYZ Coordinate Value > 0, 0, 0 

 

 

 

 

Geometry > Points > Define 

 

Keypoint > 2 
XYZ Coordinate Value > 0, -10, 0 

[Repetir para los ptos 3,…,13]. 

 
Fig. 3.33. Definición de los trece puntos. 
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Geometry > Curves > Ellipse 

 
Curve > 1 [Cresta de la fisura] 
Keypoint at end of Major axis > 4 
Keypoint at the end of Minor axis > 3 
Keypoint at center of ellipse > 1 
Number of quadrants > 1 

[Repetir para las curvas 2, 3 y 4]. 

Geometry > Curves > Line with 2 Pts 

 
Curve > 5 
Keypoint > 1 
Keypoint > 5 

[Repetir para las curvas 5,…,18]. 

 

Fig. 3.34. Definición de las dieciocho curvas. 

 

Geometry > Surfaces > Define by 4 Cr 
 
Surface > 1 
Curve > 1 
Curve > 10 
Curve > 2 
Curve > 6 

[Repetir para las superficies 2,…,5] 

Geometry > Surfaces > Define by 3 Cr 
 
Surface > 6 
Curve > 2 
Curve > 9 
Curve > 5 

 

Fig. 3.35. Definición de las seis superficies. 
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Elemento finito 
Definir el elemento PLANE2D de acuerdo a las consideraciones hechas en el inicio del 

caso. 

 

Propsets > Element Group 
 

Element Group > 1 

Element Name > PLANE2D 

 
Aceptar por defecto. 

 

 Fig. 3.36. Selección del elemento PLANE2D. 

 

Propiedades del material 
Definir las propiedades del material anteriormente mencionadas en la descripción del 

caso. 

Propsets > Material Property 
 

Material set > 1 
Material Property Name > EX 
Property value > 0.21E6 

 

 Fig. 3.37. Definición del módulo de elasticidad. 

 

Material set > 1 
Material Property Name > NUXY 
Property value > 0.28 
 

 

 Fig. 3.38. Definición del coeficiente de Poisson. 

 

Al definir por única vez el tipo de elementos y las propiedades del material, éstas variables 

quedarán asignadas para toda la geometría del modelo. 
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Asignar un determinado número de elementos por superficie. La superficie 1, 2 y 3 se 

definen cada una con 20x2 elementos, así también la superficie 4 con 20x6, la superficie 5 

con 24x6 y la superficie 6 con 20x6 elementos. Para todas las mallas se debe seleccionar 

el número de 8 como la cantidad de nodos por elemento. 

 

Meshing > Parametric Mesh > Surfaces 
 

Beginning surface > 1 
Ending surface > 3 
Increment > 1 
Number of nodes per element > 8 
Number of elem. on the 1st Cr > 20 
Number of elem. on the 2nd Cr > 2 
 
Aceptar por defecto. 

Meshing > Parametric Mesh > Surfaces 
 

Beginning surface > 4 
Ending surface > 4 
Increment > 1 
Number of nodes per element > 8 
Number of elem. on the 1st Cr > 6 
Number of elem. on the 2nd Cr > 20 
 
Aceptar por defecto. 

[Repetir para las curvas 5 y 6]  
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 

 
 
 

 
Fig. 3.39. Superficies enmalladas por elementos PLANE2D 8 nodos. 
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La extrusión de los elementos generados en 2D ofrece la posibilidad de un enmallado 

más versátil, sino la culminación geométrica de la primera parte del modelo. La dirección 

del la operación de extrusión es a lo largo del eje Z hasta una longitud de -50 mm que 

contendrá 30 elementos sólidos. Al finalizar la operación es necesario fusionar los nodos 

que coexisten en un mismo lugar mediante los comandos de Merge y Compress. 

 

Meshing > Elements > Generation > 

Extrusion 
 

Beginning Element > 1 
Ending Element > ELMAX 
Increment > 1 
Axis symbol > Z 
Total length of extrusion > -30 
Number of layers of elements > 30 
 
Aceptar por defecto. 

Meshing > Nodes > Merge 
 

Beginning Node > 1 
Ending Node > NDMAX 
Increment > 1 
Tolerance > 0.001 
 
Aceptar por defecto. 

 

Meshing > Nodes > Compress 
 

Beginning Node > 1 
Ending Node > NDMAX 

 
Fig. 3.40. Generación de elementos tridimensionales a partir de la extrusión de las 

superficies enmalladas con elementos PLANE2D 8 nodos. 

 

Geometría - Parte II 
La segunda parte del modelo necesita de la creación de los nuevos puntos, curvas y 

superficies ilustrados en la Figura 3.41. 
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Geometry > Points > Define 

 
Keypoint > 14 
XYZ Coordinate Value > 0, 0, -5 
 

Geometry > Points > Define 

 
Keypoint > 15 
XYZ Coordinate Value > 0, 0, -15 

[Repetir para los 16,…,20 puntos]. 

 

Geometry > Curves > Line with 2 Pts 

 
Curve > 20 
Keypoint > 1 
Keypoint > 14 

[Repetir para las curvas 21,…,30]. 

 

Geometry > Surfaces > Define by 4 Cr 
 
Surface > 7 
Curve > 26 
Curve > 30 
Curve > 22 
Curve > 29 

[Repetir para la superficie 8,…,10]. 

 
a) b) c) 

Fig. 3.41. Secuencia de la creación geométrica de los cordones y la plancha vertical.  

a) Puntos, b) curvas y c) superficies. 
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Se debe prestar un especial cuidado al realizar la extrusión de las superficies enmalladas 

ya que los nodos de los elementos generados por dicha operación deben coincidir con los 

nodos de la malla del modelo de la primera parte, es por ello que la operación de creación 

geométrica y posterior extrusión son reproducidas en tres ocasiones: Desde el origen 

(x=0) hasta el punto 6 (x=9 mm), desde el punto 6 hasta el punto 9 (x=12 mm) y desde el 

punto 9 hasta el punto 12 (x=50 mm). 

 

Meshing > Parametric Mesh > Surfaces 
… 

[Para las superficies 7,…,10]. 

 
Meshing > Elements > Generation > 

Extrusion 
 

Beginning Element > 1 
Ending Element > ELMAX 
Increment > 1 
Axis symbol > X 
Total length of extrusion > 9 
Number of layers of elements > 6 

Aceptar por defecto. 

Geometry > Points > Define 

… 
Geometry > Curves > Line with 2 Pts 

… 
Geometry > Surfaces > Define by 4 Cr 

… 
Meshing > Elements > Generation > 

Extrusion 
… [Desde el pto. 6 al pto. 10]. 

 

[Repetir la secuencia de creación: 

Points, Curves, Surfaces y Extrusion; 

desde el pto. 10 al pto. 12]. 

 

Una vez finalizada la geometría de la parte II, se debe inspeccionar que los lados de los 

elementos coincidan y posteriormente realizar la fusión de los nodos que ocupan un 

mismo lugar en el espacio garantizando la convergencia entre ellos. 

 

Meshing > Nodes > Merge 
 

Beginning Node > 1 
Ending Node > NDMAX 
Increment > 1 
Tolerance > 0.001 

Aceptar por defecto. 

Meshing > Nodes > Compress 
 

Beginning Node > 1 
Ending Node > NDMAX 
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Fig. 3.42. Extrusión a lo largo del eje x en tres etapas delimitadas por las coordenadas x 

de los puntos 6, 10 y 12. 

  
 
 
 
 

 
 

 

 
 

 

 
 

 
Fig. 3.43. Vistas de la unión soldada donde se puede apreciar la coincidencia entre los 

bordes de los elementos. 
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Geometría - Parte III 
Crear una geometría similar a la del modelo de la parte I, cuya extrusión finaliza en el 

z=30 mm en cuya longitud se pueden contabilizar 18 elementos. Los puntos creados para 

para la parte III tienen las mismas coordenadas x e y de los puntos creados para la parte I 

de la Figura 3.44, y una coordenada z igual a 0.0001 mm. 

 

Geometry > Points > Define 

 

Keypoint > 35 
XYZ Coordinate Value > 0,0,0.0001 

 

Geometry > Points > Define 

 

Keypoint > 36 
XYZ Coordinate Value > 9,0,0.0001 

[Repetir para los puntos 37,…,47]. 

Geometry > Curves > Ellipse 

… 
Geometry > Curves > Line with 2 Pts 

… 
Geometry > Surfaces > Define by 4 Cr 

… 
[Generar las superficies 19,...,24]. 

 

 

Fig. 3.44. Superficies generadas para el desarrollo geométrico de la parte III. 
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Meshing > Parametric Mesh > Surfaces 
… 

Meshing > Elements > Generation > 

Extrusion 
 

Beginning Element > 1 
Ending Element > ELMAX 
Increment > 1 
Axis symbol > Z 
Total length of extrusion > 30 
Number of layers of elements > 18 

Aceptar por defecto. 

 

 

Fig. 3.45. Extrusión de las superficies enmalladas a lo largo del eje Z. 

 

Culminada la operación de extrusión se necesita que la parte III forme un único modelo 

con el resto de la geometría creada (parte I y II), lo cual será alcanzado con la fusión de 

los nodos contenidos en las superficies comunes sin tomar en consideración a los nodos 

de las superficies de la fisura (superficie 1, 6, 19 y 24). Es recomendable limpiar la 

pantalla con el icono Clear screen de Geo Panel con la finalidad de facilitara el trabajo del 

usuario. 
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Control > Select > by Reference 
 

Selection Entity > ND: Node 
Reference Entity > SF: Surface 
Beginning Surface > 2 
Ending Surface > 20 
Increment > 18 
 

Meshing > Nodes > Merge 
 

Beginning Node > 1 
Ending Node > NDMAX 
Increment > 1 
Tolerance > 0.001 

Meshing > Nodes > Compress 
 

Beginning Node > 1 
Ending Node > NDMAX 
 

 

[Repetir la secuencia:  

Control > Select > by Referente, 
Meshing > Nodes > Merge,  
Meshing > Nodes > Compress;  
para alcanzar la fusión de los nodos de 

las combinaciones de las superficies:3-

21, 4-22 y 5-23]. 

 

Fig. 3.46. Nodos fusionados con el objetivo de generar la fisura entre las superficies 1, 6, 

19 y 24. 

 

Fisura 
Definir los puntos A y B como cabezas de fisura para que el programa considere la 

singularidad de esfuerzos involucrado en un análisis de fractura. Limpiar la pantalla, 

plotear la curva 1 para identificar la ubicación de la fisura. Es preciso identificar los 
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elementos cuyos nodos representarán los puntos A y B, mediante el comando Edit > 

Identify > Elements. Después de identificarlos se debe plotear y etiquetar sus nodos para 

facilitar la tarea de definir las fisuras. Para visualizar el modelo geométrico se debe limpiar 

la pantalla, inicializar cualquier selección y plotear todos los elementos. 

 

Geometry > Curves > Editing > Plot 
 

Beginning Curve > 1 
Ending Curve > 1 
Increment > 1 

 
Control > Select > by Range 

 

Coordinate system > EL: Element 
Coordinate active. flag for X, Y, Z > 1 
X Coordinate lower range > 0 
X Coordinate higher range > 50 
Y Coordinate lower range > -10 
Y Coordinate higher range > 0 
Z Coordinate lower range > -1.7 
Z Coordinate higher range > 0 

 

Edit > Identify > Elements 

[Click sobre el elemento de interés para 

determinar su numeración ] 

 

Control > Select> by Reference 
 

Selection Entity > ND: Node 
Reference Entity > EL: Element 
Beginning Surface > 505 
Ending Surface > 1075 
Increment > 570 

Control > Active > Entity Label 
 

Entity > ND: Node 
Number plotting flag > On: 1 
 

Analysis > Static > Crack > Define 
Crack 
 

Crack number > 1 [Punto A]. 
Node 1 > 1 
Node 2 > 63 
Node 3 > 3 
 
Crack number > 2 [Punto B]. 

Node 1 > 41 
Node 2 > 103 
Node 3 > 39 
 

Control > Select> Initialize 
 

Entity Name > ALL 
Aceptar por defecto. 

 
Geometry > Element > Editing > Plot 

 

Beginning Element > 1 
Ending Element > ELMAX 
Increment > 1 
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Fig. 3.47. Identificación de los nodos y su posterior definición de los puntos A y B. 

 

Para obtener la vista completa del modelo bajo la perspectiva que muestra la Figura 3.3, 

es necesario utilizar el icono Rotate de Geo Panel y activar el icono Y para producir el 

giro del modelo sobre su eje Y. 

 
 

 

 
 
  

 
 

 
 

 
 
 

 

Fig. 3.48. Modelo geométrico completo con la fisura definida. 
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Condiciones de contorno 
Impedir el desplazamiento X (UX) a todos los nodos contenidos en el plano de simetría 

mediante la opción LoadsBC > Structural > Displacement > Define by Nodes, como son 

ilustradas en la Figura 3.3. Aplicar restricción UY sobre los nodos contenidos sobre las 

dos aristas de la base que son paralelas a la fisura, además sobre los nodos contenidos 

sobre una de estas aristas definir también restricciones en UZ. La selección de nodos 

resulta ser una tarea fácil si éstos estarían contenidas en una curva previamente creada, 

pero los nodos fueron generados por extrusión así es que deben ser seleccionados 

mediante rangos. 

 

Control > Select > by Range 
 

Coordinate system > ND: Node 
Coordinate active. flag for X, Y, Z > 1 
X Coordinate lower range > -1 
X Coordinate higher range > 0.001 
Y Coordinate lower range > -11 
Y Coordinate higher range >21 
Z Coordinate lower range > -51 
Z Coordinate higher range > 31 

LoadsBC > Structural > Displacement > 

Define by Nodes 
 

Beginning Node > 1 
Displacement Label > UX 
Value > 0 
Ending Node > NDMAX 
Increment > 1 

 
 
 
 
 
 
 

 
 

 

 
 

 

Fig. 3.49. Restricción UX sobre los nodos contenidos en el plano de simetría. 
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Para el primer grupo de nodos que tendrán restringido el desplazamiento en Y e Z 

Control > Select> Initialize 
 

Entity Name > ND: Node 
Aceptar por defecto. 
 

Control > Select > by Range 
 

Coordinate system > ND: Node 
Coordinate active. flag for X, Y, Z > 1 
X Coordinate lower range > -1 
X Coordinate higher range > 51 
Y Coordinate lower range > -11 
Y Coordinate higher range >-9.8 
Z Coordinate lower range > 29.8 
Z Coordinate higher range > 31 

LoadsBC > Structural > Displacement > 

Define by Nodes 
 

Beginning Node > 1 
Displacement Label > UY 
Value > 0 
Ending Node > NDMAX 
Increment > 1 
 
Beginning Node > 1 
Displacement Label > UZ 
Value > 0 
Ending Node > NDMAX 
Increment > 1 

 

Segundo grupo de nodos que tendrán restringido el desplazamiento en Y. 

 

Control > Select> Initialize 
 

Entity Name > ND: Node 
Aceptar por defecto. 
 

Control > Select > by Range 
 

Coordinate system > ND: Node 
Coordinate active. flag for X, Y, Z > 1 
X Coordinate lower range > -1 
X Coordinate higher range > 51 
Y Coordinate lower range > -11 
Y Coordinate higher range >-9.8 
Z Coordinate lower range > -51 
Z Coordinate higher range > -49.8 

LoadsBC > Structural > Displacement > 

Define by Nodes 
 

Beginning Node > 1 
Displacement Label > UY 
Value > 0 
Ending Node > NDMAX 
Increment > 1 
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º 

Fig. 3.50. Restricción UY y UZ sobre los nodos contenidos en una de las aristas de la 

base. 

 

Para aplicar los esfuerzos de membrana sobre el modelo, se debe seleccionar los 

elementos ubicados en los extremos de la plancha horizontal y definir la carga sobre la 

cara externa. Para contar con un mejor ambiente de trabajo se recomienda limpiar la 

pantalla (Clear Screen) e inicializar cualquier selección hecha previamente, a continuación 

seleccionar el grupo de elementos ubicado en uno de los extremos mediante un rango 

(Control > Select > by Range), para luego imponer la carga en forma de presión sobre 

éstos mediante la opción LoadsBC > Structural > Pressure > Define by Elements. Cuando 

la carga es aplicada sobre una de las caras seleccionada de los elementos, se debe 

verificar que la fecha, que simboliza la presión ejercida sobre el nodo, tiene una dirección 

normal a la superficie del elemento y que su sentido sea el correcto. 
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Control > Select> Initialize 
… 
Control > Select > by Range 

 

Coordinate system > EL: Elements 
Coordinate active. flag for X, Y, Z > 1 
X Coordinate lower range > -1 
X Coordinate higher range > 51 
Y Coordinate lower range > -11 
Y Coordinate higher range >1 
Z Coordinate lower range > 28 
Z Coordinate higher range > 31 

 

LoadsBC > Structural > Pressure > 

Define by Elements 
 

Beginning Element > 1 
Pressure magnitude > -100 
Face number [1,6] > 6 
Ending Element > ELMAX 
Increment > 1 
Pressure direction > 4 Normal 

Control > Select> Initialize 
… 
Control > Select > by Range 

 

Coordinate system > EL: Elements 
Coordinate active. flag for X, Y, Z > 1 
X Coordinate lower range > -1 
X Coordinate higher range > 51 
Y Coordinate lower range > -11 
Y Coordinate higher range >1 
Z Coordinate lower range > -51 
Z Coordinate higher range > -48 

 

LoadsBC > Structural > Pressure > 

Define by Elements 
 

Beginning Element > 1 
Pressure magnitude > -100 
Face number [1,6] > 6 
Ending Element > ELMAX 
Increment > 1 
Pressure direction > 4 Normal 

 

Fig. 3.51. Elementos seleccionados por rango en cuya cara externa es aplicado el 

esfuerzo de membrana. 
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El esfuerzo de flexión será aplicado bajo su equivalente de un par de fuerzas y a su vez 

cada fuerza puntual es distribuida en diez nodos, como lo ilustra la Figura 3.3. Una vez 

calculada la fuerza por nodo, debe ser aplicada en tracción sobre cinco nodos 

equidistantes entre sí y de igual forma en compresión. 
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2 2twM b
b

σ
=  

Donde: 

2
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==  
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N
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===  

N
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10

000,5* ===  

 
 

 

 

 
 

 

 
Fig. 3.52. Equivalencia del esfuerzo flector 

a fuerzas puntuales. 

 

Plotear los nodos que se encuentra contenidos en los elementos anteriormente 

seleccionados, es preciso identificar los nodos mediante la opción Edit > Identify > Nodes 

para extraer información sobre su ubicación y numeración, logrando de esta forma que la 

tarea de imponer las cargas puntuales sea más ágil. 
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Control > Select> by Reference 
 

Selection Entity > ND: Node 
Reference Entity > EL: Element 
Beginning Surface > 1 
Ending Surface > ELMAX 
Increment > 1 

 
Edit > Identify > Nodes 

[Click sobre el nodo de interés para 

determinar su ubicación y numeración]. 

LoadsBC > Structural > Force > Define 
by Nodes 
 

Beginning Node > 1 
Force label > FZ: Force in Z 
Value > 500 
Ending Node > 1 
Increment > 1 

[Repetir la operación para los cinco 

nodos a tracción y para los cinco nodos 

en compresión considerar -500]. 
 

 
 

 

Fig. 3.53. Fuerza por nodo aplicada en tracción y en compresión. 

 

Análisis 
Analizar el caso bajo un estudio elástico lineal. 

 

Geo Panel: 

Analysis > Static > Run Static Analysis 

 

Resultados 
Visualizar los resultados gráficamente como un campo de esfuerzos resultantes (von 

Mises) de diferentes intensidades sobre el modelo distorsionado por la tensión aplicada. 
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Control > Select> Initialize 
 

Entity Name > ND: Node 
Aceptar por defecto. 

Results > Plot > Stress 
 

Component > VON: von Mises stress 

Shape flag > 1: Deformed 
Deformed scale factor > 120 

 
 

 
 

 
  

Fig. 3.54. Esfuerzos von Mises del modelo deformado bajo una escala 120. 
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Los resultados del factor de intensidad de tensiones que caracterizará la tenacidad de la 

fractura de los puntos A y B están registrados en un archivo de extensión .out y puede ser 

encontrado mediante la opción File > Edit file 

 

 
Geo Panel: 

File > Edit file 
Filename > “name”.out 

 

CRACK STRESS INTENSITY FACTORS FOR CRACK 1 

(using displacement method) 

 

KI = 0.277682E+03 

 

CRACK STRESS INTENSITY FACTORS FOR CRACK 2 

(using displacement method) 

 

KI = 0.366759E+03 

 

Fig. 3.55. K modo-I de fractura evaluado en los puntos A 

(Crack 1) y B (Crack 2) de una fisura superficial semi-

elíptica ubicada en una unión de filete 

 

Los resultados de la modelación tienen como unidades Nmm-3/2, para ser comparada con 

la tenacidad crítica del material AISI 4130 (ver Tabla 3.7) es necesario realizar la 

conversión a Nm-3/2. Al comparar los valores críticos del acero con los resultados de la 

modelación, se puede afirmar que la fisura contenida en la plancha, no se propaga bajo 

las condiciones en que se encuentra. La inestabilidad de la fisura se produce cuando el 

valor de la tenacidad se aproxima peligrosamente al valor crítico de 110x106 Nm-3/2. 

 

Tabla 3.7. Valor de tenacidad crítica de un acero AISI 4130 y los IK  calculados por 

COSMOS/M en el punto A y B. 

Material Punto 
Tenacidad crítica COSMOS/M 

ICK )( 2/3−mN  IK )( 2/3−mmN  IK )( 2/3−mN  
AISI 4130 A (Crack 1) 110x106 277.682 8.8x106 

AISI 4130 B (Crack 2) 110x106 366.759 11.6x106 
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CONCLUSIONES. 
 

 Conclusiones de la modelación bidimensional: 

 

Los resultados de la modelación de los especimenes CCT, DENT y SENT han generado 

mínimas diferencias al ser comparados con los valores analíticos de las respectivas 

referencias. El análisis del espécimen CCT arroja los mejores resultados para la malla 3 y 

si se comparan las curvas generadas por los resultados de la modelación y de los valores 

analíticos en un diagrama K  vs a , es posible apreciar que ambas tienen la misma 

tendencia y que el error entre ellas es despreciables (promedio –0.01%). El análisis de los 

especimenes DENT y SENT arroja los mejores resultados cuando son evaluados bajo una 

la malla 2. Al comparar los resultados en un diagrama K  vs a , las curvas de la 

modelación y de los valores analíticos tienen la misma tendencia, y los valores de error 

son bajos, cuyo promedio es igual a –2.5% para DENT y de –3.4% para SENT. 

 

Los resultados de la modelación de los especimenes CCT, DENT y SENT son 

satisfactorios, confirman que la metodología empleada para el análisis de un problema de 

fractura elasto-lineal es adecuada, permitiendo afirmar la factibilidad de la modelación 

bidimensional con el programa seleccionado. 

 

 Conclusiones de la modelación tridimensional:  

 

La modelación practicada a la plancha que contiene una fisura superficial semi-elíptica, 

ofrece resultados muy similares a los valores calculados mediante expresiones analíticas. 

Para la validación de los resultados del punto “ A ”, cuando la fisura crece verticalmente, 

se generó curvas en un diagrama K  vs a , donde es posible apreciar que los resultados 

analíticos y de la modelación tienen la misma tendencia y son similares, cuyo error 

promedio es igual a 0,9%. Cuando la fisura crece horizontalmente, la tendencia de las 

curvas en un diagrama K  vs c  es similar con un error promedio de 1,4% entre sus 

valores. La tarea de validación del punto “ B ” encontró tendencia similares y errores bajos, 

cuando la fisura crece verticalmente el error promedio es igual a -3,1% y cuando la fisura 

crece horizontalmente el error promedio es igual a -0,7%. 
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Los resultados obtenidos de K  para una fisura superficial semi-elíptica en una unión 

soldada de filete manifiestan tendencias similares a los resultados analíticos, concluyendo 

que el comportamiento de la fisura es correctamente interpretado por el software. La 

evaluación del punto “ A ” cuando la fisura crece de forma vertical y horizontal se 

obtuvieron errores promedio de -41,4% y de -31,5%, respectivamente, siendo estos 

valores muy altos que no posibilitan la validación para este caso. A diferencia del punto 

“ A ”, el análisis del punto “ B ” generó errores bajos, cuyos valores son de -6,4% cuando la 

fisura crece de forma vertical y de -7,4% cuando la fisura crece de horizontal. 

Después de realizar el análisis de los resultados del estudio de la fractura elasto-lineal en 

una unión de filete, se puede indicar que la tarea de validar no se pudo concretar, 

quedando dicha tarea en una comparación de resultados. Se recomienda continuar con el 

estudio del caso con la intención de encontrar el origen de las diferencias entre los valores 

analíticos y los resultados de la modelación. 

 Conclusiones generales:

La comparación de los resultados obtenidos por el programa y los valores analíticos, fue 

un método muy eficaz para alcanzar la validación de los resultados de la modelación. Las 

expresiones contenidas en la bibliografía de H. Tada, “The stress analysis of cracks 

handbook”, y en la norma API, “Recommended practice 579 Fitness for service”, cuentan 

con un fuerte sustento teórico y pueden ser tomadas como referencias. 

Se puede considerar la inexistencia de particularidades desde el punto de vista de las 

propiedades del material para efectos de la caracterización de la tenacidad a la fractura 

elasto-lineal de una unión soldada (uniones soldadas no disímiles), ya que el material 

base y el cordón de soldadura comparten valores de módulo de elasticidad y de 

coeficiente de Poisson muy similares. El esfuerzo de fluencia de un material base y de un 

cordón de soldadura poseen una significativa diferencia, pero esta propiedad tiene 

repercusión en la caracterización de la tenacidad de la fractura elasto-plástica con la J -

Integral o con CTOD. 

Se puede afirmar la factibilidad del análisis de la fractura elástica lineal apoyado de 

herramientas computacionales, lo cual nos da la gran posibilidad de tratar problemas 
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concretos de la industria con ayuda de un software de elementos finitos en dos 

dimensiones. La posibilidad de tratar problemas tridimensionales requiere de más 

estudios y será de tema de posteriores investigaciones. 
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